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License Information

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the “Software”), to deal in the Software without restriction,
including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or
sell copies of the Software, and to permit persons to whom the Software is furnished to do so.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL
THE AUTHORS BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL
DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

CLIPS is released as public domain software and as such you are under no obligation to pay for
its use. However, if you derive commercial or monetary benefit from use of the software or just
want to show support, please consider making a voluntary payment based on the worth of the
software to you as compensation for the time and effort required to develop and maintain CLIPS.
Payments can be made online at http://order.kagi.com/?JKT.
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Preface

The History of CLIPS

The origins of the C Language Integrated Production System (CLIPS) date back to 1984 at
NASA’s Johnson Space Center. At this time, the Artificial Intelligence Section (now the
Software Technology Branch) had developed over a dozen prototype expert systems applications
using state-of-the-art hardware and software. However, despite extensive demonstrations of the
potential of expert systems, few of these applications were put into regular use. This failure to
provide expert systems technology within NASA’s operational computing constraints could
largely be traced to the use of LISP as the base language for nearly all expert system software
tools at that time. In particular, three problems hindered the use of LISP based expert system
tools within NASA: the low availability of LISP on a wide variety of conventional computers,
the high cost of state-of-the-art LISP tools and hardware, and the poor integration of LISP with
other languages (making embedded applications difficult).

The Artificial Intelligence Section felt that the use of a conventional language, such as C, would
eliminate most of these problems, and initially looked to the expert system tool vendors to
provide an expert system tool written using a conventional language. Although a number of tool
vendors started converting their tools to run in C, the cost of each tool was still very high, most
were restricted to a small variety of computers, and the projected availability times were
discouraging. To meet all of its needs in a timely and cost effective manner, it became evident
that the Artificial Intelligence Section would have to develop its own C based expert system tool.

The prototype version of CLIPS was developed in the spring of 1985 in a little over two months.
Particular attention was given to making the tool compatible with expert systems under
development at that time by the Artificial Intelligence Section. Thus, the syntax of CLIPS was
made to very closely resemble the syntax of a subset of the ART expert system tool developed
by Inference Corporation. Although originally modelled from ART, CLIPS was developed
entirely without assistance from Inference or access to the ART source code.

The original intent for CLIPS was to gain useful insight and knowledge about the construction of
expert system tools and to lay the groundwork for the construction of a replacement tool for the
commercial tools currently being used. Version 1.0 demonstrated the feasibility of the project
concept. After additional development, it became apparent that CLIPS would be a low cost
expert system tool ideal for the purposes of training. Another year of development and internal
use went into CLIPS improving its portability, performance, functionality, and supporting
documentation. Version 3.0 of CLIPS was made available to groups outside of NASA in the
summer of 1986.

Further enhancements transformed CLIPS from a training tool into a tool useful for the
development and delivery of expert systems as well. Versions 4.0 and 4.1 of CLIPS, released
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respectively in the summer and fall of 1987, featured greatly improved performance, external
language integration, and delivery capabilities. Version 4.2 of CLIPS, released in the summer of
1988, was a complete rewrite of CLIPS for code modularity. Also included with this release
were an architecture manual providing a detailed description of the CLIPS software architecture
and a utility program for aiding in the verification and validation of rule-based programs.
Version 4.3 of CLIPS, released in the summer of 1989, added still more functionality.

Originally, the primary representation methodology in CLIPS was a forward chaining rule lan-
guage based on the Rete algorithm (hence the Production System part of the CLIPS acronym).
Version 5.0 of CLIPS, released in the spring of 1991, introduced two new programming
paradigms: procedural programming (as found in languages such as C and Ada) and
object-oriented programming (as found in languages such as the Common Lisp Object System
and Smalltalk). The object-oriented programming language provided within CLIPS is called the
CLIPS Object-Oriented Language (COOL). Version 5.1 of CLIPS, released in the fall of 1991,
was primarily a software maintenance upgrade required to support the newly developed and/or
enhanced X Window, MS-DOS, and Macintosh interfaces. Version 6.0 of CLIPS, released in
1993, provided support for the development of modular programs and tight integration between
the object-oriented and rule-based programming capabilities of CLIPS. Version 6.1 of CLIPS,
released in 1998, removed support for older non-ANSI C Compilers and added support for C++
compilers. Commands to profile the time spent in constructs and user-defined functions were
also added.

Because of its portability, extensibility, capabilities, and low-cost, CLIPS has received
widespread acceptance throughout the government, industry, and academia. The development of
CLIPS has helped to improve the ability to deliver expert system technology throughout the
public and private sectors for a wide range of applications and diverse computing environments.
CLIPS is being used by numerous users throughout the public and private community including:
all NASA sites and branches of the military, numerous federal bureaus, government contractors,
universities, and many private companies.

CLIPS is now maintained as public domain software by the main program authors who no longer
work for NASA. See appendix A of the Basic Programming Guide for information on obtaining
CLIPS and support.

CLIPS Version 6.2

Version 6.2 of CLIPS contains two major enhancements. First, CLIPS now provides a
mechanism which allows an embedded application to create multiple environments into which
programs can be loaded. Second, an improved Windows 95/98/NT CLIPS interface is now
available and the Macintosh CLIPS interface has been enhanced to support MacOS X. For a
detailed listing of differences between the 6.x releases of CLIPS, refer to appendix B of the Basic
Programming Guide and appendix C of the Advanced Programming Guide.
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CLIPS Documentation
Two documents are provided with CLIPS.
e The CLIPS Reference Manual which is split into the following parts:

e Volume I - The Basic Programming Guide, which provides the definitive description of
CLIPS syntax and examples of usage.

*  Volume II - The Advanced Programming Guide, which provides detailed discussions of
the more sophisticated features in CLIPS and is intended for people with extensive
programming experience who are using CLIPS for advanced applications.

*  Volume Il - The Interfaces Guide, which provides information on machine-specific
interfaces.

e The CLIPS User’s Guide which provides an introduction to CLIPS rule-based and
object-oriented programming and is intended for people with little or no expert system
experience.
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Section 1 - Introduction

This manual is the Interfaces Guide for CLIPS. It is intended for users interested in using the
machine specific interfaces for CLIPS. Section 2 of this manual describes the IBM PC
compatible Windows interface for CLIPS, Section 3 describes the Macintosh interface for
CLIPS, and Section 4 describes the X Window interface for CLIPS.
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Section 2 - CLIPS Windows Interface

This section provides a brief summary of each menu command found in the CLIPS 6.2 Windows
interface. The menus are listed in the left to right order in which they appear in the menu bar.
The commands within each menu are also listed in the order in which they appear in the menu.

The rest of the CLIPS 6.2 Windows interface is straightforward, following Windows interface
standards. Commands can be entered directly in the dialog window in a fashion similar to the
standard CLIPS command line interface. The integrated editor is implemented in a fashion
similar to that of other Windows editors.

If rules are not being executed, then execution of the current command or CLIPS program can be
halted by holding down the control key while pressing the period key. If rules are being
executed, then rule execution can be interrupted on a rule firing boundary by holding the control
key while pressing the period key. Holding down the shift key, the control key, and the period
key will halt rule execution after the current RHS action. The Halt menu item can also be
selected from the Execution menu during execution. Selecting this menu item is equivalent to
holding down the control key while pressing the period key. If the shift key is held down before
clicking in the menu bar, the Halt menu item is changed to the Halt Now! menu item. Selecting
this menu item is equivalent to holding down the shift key and the control key while pressing the
period key.

Some menu commands are available while CLIPS is executing a user program. Among these
commands are the Options... menu item, the Watch... menu item, the Turn Dribble On.../Turn
Dribble Off menu item, and all menu items in Window menu. The command summary for each
menu item indicates whether it is available while CLIPS is executing. In addition, windows may
be moved and re-sized while CLIPS is executing.
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2.1 THE FILE MENU

Mew Ctrl+M
Qpen... Ctrl+0
Load... Chrl+L
Load Batch...

Load Binary...

Turn Dinbble On...

Cloze

Save Ctrl+5
Save Az

Save Binam...

Rewvert

Fage Setup...
Frint... Ctrl+FP

E xit

2.1.1 New (Ctrl+N)

This command opens a new buffer for editing with the window name Untitled.

2.1.2 Open... (Ctrl+0O)

This command displays the standard Windows file selection dialog box, allowing the user to
select a text file to be opened as a buffer for editing.

2.1.3 Load... (Ctrl+L)

This command displays the standard Windows file selection dialog box, allowing the user to
select a text file to be loaded into the knowledge base. This command is equivalent to the CLIPS
command (load <file-name>). When this command is chosen and a file is selected, the
appropriate CLIPS load command will be echoed to the dialog window and executed. This
command is not available when CLIPS is executing.
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Note: when using the CLIPS command (load <file-name>) specify the path using the forward
slash character '/' or a double backslash '\\' instead of the standard DOS delimiter '\'.

For example,

(load "C: / CLIPSWIN / EXAMPLES / TEST.CLP")

or

(load "C: \\ CLIPSWIN \\ EXAMPLES \\ TEST.CLP™)

2.1.4 Load Batch...

This command displays the standard Windows file selection dialog box, allowing the user to
select a text file to be executed as a batch file. This command is equivalent to the CLIPS
command (batch <file-name>). When this command is chosen and a file is selected, the
appropriate CLIPS batch command will be echoed to the dialog window and executed. This
command is not available when CLIPS is executing.

2.1.5 Load Binary...

This command displays the standard Windows file selection dialog box, allowing the user to
select a file to be loaded as a binary image. This command is equivalent to the CLIPS command
(bload <file-name>). When this command is chosen and a file is selected, the appropriate CLIPS
bload command will be echoed to the dialog window and executed. This command is not
available when CLIPS is executing.

2.1.6 Turn Dribble On...

This command displays the standard Windows file selection dialog box, allowing the user to
select a text file in which subsequent display window output will be stored. This command is
equivalent to the CLIPS command (dribble-on <file-name>). When this command is chosen and
a file is selected, the appropriate CLIPS dribble-on command will be echoed to the dialog
window and executed. While the dribble file is active, this menu item will be modified to read
Turn Dribble Off. Selecting the menu item at this time will close the dribble text file. The Turn
Dribble Off command is equivalent to the CLIPS command (dribble-off). This command is
available when CLIPS is executing (however the commands will not be echoed to the dialog
window).

2.1.7 Close

This command closes the currently active edit or status window.
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2.1.8 Save (Ctrl+S)

This command saves the file in the active edit window or the contents of the dialog or status
window. If the file is Untitled, the Dialog window, or a status window , a dialog box will prompt
for a file name under which to save the file. The file type option in the standard file dialog box
determines whether a file is saved as a batch file or a text file. CLIPS batch file documents are
executed as a series of commands when launched, whereas CLIPS text file documents are placed
in an editing buffer when launched. Both types of documents can be edited as text files in the
editor.

2.1.9 Save As...

This command allows the active edit window to be saved under a new name. A dialog box will
appear to prompt for the new file name. The name of the editing window will be changed to the
new file name.

2.1.10 Save Binary...

This command allows the constructs currently stored in CLIPS to be saved as a binary image. A
dialog box will appear to prompt for the new file name in which to store the binary image. This
command is equivalent to the CLIPS command (bsave <file-name>). When this command is
chosen and a file is selected, the appropriate CLIPS bsave command will be echoed to the dialog
window and executed. This command is not available when CLIPS is executing.

2.1.11 Revert

This command restores the active edit window to the last-saved version of the file in the buffer.
Any changes made since the file was last saved will be discarded.

2.1.12 Page Setup...

This command allows the user to specify information about the size of paper used by the printer.

2.1.13 Print... (Ctrl+P)

This command allows the user to print the active edit window.

2.1.14 Exit

This command exits CLIPS. This command is not available when CLIPS is executing.
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2.2 THE EDIT MENU
Undo Ctrl+Z
Cut Chrl+2
Copy Chl+C
Paste Chrl+vf
Delete Del
Select Al
B alance Ctrl+B
Comrment — Chil+;
Uncornment  Cril+L
Set Font...

2.2.1 Undo (Ctrl+Z)

This command allows you to undo your last editing operation. Typing, cut, copy, paste, and
delete operations can all be undone.

2.2.2 Cut (Ctr1+X)

This command removes selected text in the edit window and places it in the Clipboard.

2.2.3 Copy (Ctrl+C)

This command copies selected text in the edit window and places it in the Clipboard.

2.2.4 Paste (Ctrl+V)

This command copies the contents of the Clipboard to the selection point in the edit window or
the Dialog window. If there is selected text in the edit window, it is replaced by the contents of
the Clipboard.
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2.2.5 Delete

This command removes selected text in the edit window. The selected text is not placed in the
Clipboard.

2.2.6 Select All

This command selects all of the text in the active edit window.

2.2.7 Balance (Ctrl+B)

This command operates on the current selection in the edit window by attempting to find the
smallest selection containing the current selection which has balanced parentheses. Repeatedly
using this command will select larger and larger selections of text until a balanced selection
cannot be found. The balance command is a purely textual operation and can be confused by
parentheses found in strings.

2.2.8 Comment (Ctrl+;)

This command operates on the current selection in the active edit window by adding a semicolon
to the beginning of each line contained in the selection.

2.2.9 Uncomment (Ctrl+U)

This command operates on the current selection in the active edit window by removing a
semicolon (if one exists) from the beginning of each line contained in the selection.

2.2.10 Set Font...

This command allows the font used in the currently active editing buffer to be changed. When
you use this command, the following dialog will appear:
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Font 2]
Font: Font zhyle: Size
Courier Mew Reqular 10 ak
Fixedsys Italic 11 =l cance
M Garamond — Bold 12
T Gill 5ans Bald Italic 14
% Gill 5an: Condenzed 16
Gill Sanz Ultra Bald 18
H GulimChe | 2 B i
Effects Sample
[ Stikeout
LaBh¥wa
[ Underline = e
Color:
|- Black j Script:
|We&tern j

Select the desired font and font attributes in the dialog. The letters in the Sample area will be
displayed using the selected font. Click the OK button to change the font used in the currently
active editing buffer. Click the Cancel button to retain the current font setting.

2.3 THE BUFFER MENU
Find Chrl+F
Replace Chrl+H

Load Selection  Chl+E.
Batch Selection Crrl+hd
Load Buffer
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2.3.1 Find (Ctrl+F)

This command displays a dialog box which allows the user to set parameters for text search
operations. The dialog box that appears allows a search string to be specified.

Find Fl B

Find what: |Deftem|:||ate Find Mext
Cancel

[ Match caze

The Match Case option makes the string search operation case-insensitive for alphabetic
characters; that is, the string “Upper” will not match the string “uPPER”. The default for this
setting is off.

Once search options have been set, one of three search dialog buttons can be pressed. The Find
Next button will search for teach occurrence of the string in the edit window starting at the end
of the current selection and preceding to the end of the buffer. The Cancel button aborts the find
command. The search options are restored to the values they had before the dialog box was
entered.

2.3.2 Replace (Ctrl+H)

This command displays a dialog box which allows the user to set parameters for text search and
replacement operations. The dialog box that appears allows a search and replacement string to
be specified.

Heplace

Find what; |[|:-rir'|t|:uut Eind Mext

Feplace with: |;[|:|rint|:|ut Replace
Replace Al

[ Match case Cancel
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The Match Case option makes the string search operation case-insensitive for alphabetic
characters; that is, the string “Upper” will not match the string “uPPER”. The default for this
setting is off.

Once search options have been set, one of three search dialog buttons can be pressed. The Find
Next button will search for each occurrence of the “Find What” string in the edit window
starting at the end of the current selection and preceding to the end of the buffer. The Replace
button will replace one instance of the “Find What” string with the “Replace With” string. The
Replace All button will replace every instance of the “Find What” string with the “Replace
With” string without user verification. The Cancel button aborts the replace command. The
search and replace strings and options are restored to the values they had before the dialog box
was entered.

2.3.3 Load Selection (Ctrl+K)

This command loads the current selection from the edit window into the CLIPS knowledge base.
Standard error detection and recovery routines used to load constructs from a file are also used
when loading a selection (i.e., if a construct has an error in it, the rest of the construct will be
skipped over until another construct to be loaded is found). This command is not available when
CLIPS is executing.

2.3.4 Batch Selection (Ctrl+M)

This command treats the current selection in the edit window as if it were a batch file and
executes it as a series of commands. Standard error detection and recovery routines used to load
construct from a file are not used when batching a selection (i.e., if a construct has an error in it,
a number of ancillary errors may be generated by subsequent parts of the same construct
following the error). This command is not available when CLIPS is executing.

2.3.5 Load Buffer
This command loads the contents of the active edit window into the CLIPS knowledge base. It is

equivalent to selecting the entire buffer and executing a Load Selection command. This
command is not available when CLIPS is executing.
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2.4 THE EXECUTION MENU
Execution
Rezet Ctrl+E
Run Ctrl+R
Step Chrl+T
Wiatch... Chrl+af
Options. ..
Preferences. .
Clear CLIPS
2.4.1 Reset (Ctrl+E)

This command is equivalent to the CLIPS command (reset). When this command is chosen, the
CLIPS command (reset) will be echoed to the dialog window and executed. If Warnings are
enabled and activation's are currently on the agenda, a dialog box will appear issuing a warning
and providing an opportunity to cancel this command. This command is not available when
CLIPS is executing.

2.4.2 Run (Ctrl+R)

This command is equivalent to the CLIPS command (run). When this command is chosen, the
CLIPS command (run) will be echoed to the dialog window and executed. During execution, this
menu command is changed to Halt and can be selected to halt execution (as if a command period
had been entered). Holding the shift key down while selecting this menu item is equivalent to
entering command-shift-period. For an explanation of the different methods of halting execution
refer to the introduction at the beginning of this section.

2.4.3 Step (Ctrl+T)

This command is equivalent to the CLIPS command (run <limit>) where <limit> is the value for
the Step Rule Firing Increment. (it is set using the Options... command under the Edit menu).
When this command is chosen, the CLIPS command (run <limit>) will be echoed to the dialog
window and executed. If the default value for the Step Rule Firing Increment is used, this
command is equivalent to the CLIPS command (run 1). This command is not available when
CLIPS is executing.
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2.4.4 Watch... (Ctrl+W)

This command displays a dialog box which allows the user to set various watch items as enabled
or disabled.

¥ LCompistons [ Deffunctions
[ Facts [ Generic Functions
[ Rules [ Methods
[ Statistics [ Instances
[ Activations [ Slots
[ Focus [ Message-handlers
[ Globals [ Meszages

Al Mone

LCancel [H]

Watch items can be enabled or disabled by clicking the appropriate check box. Enabled watch
items have a check in their check box. Disabled watch items have no check mark in their check
box. Pressing the All button checks all of the watch item check boxes. Pressing the None button
unchecks all of the watch item check boxes. Clicking the OK button exits the dialog and changes
the current watch settings to those shown in the dialog. Clicking the Cancel button exits the
dialog, but retains the original settings of the watch items before the dialog was entered.

This command is available when CLIPS is executing.
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2.4.5 Options...

This command displays a dialog box which allows the user to set various CLIPS execution
options.

Execution Options

Salience Ewvaluation:

Strateqy: | Diepth -

[v Static Constraint Checking v Incremental Feset
[ Diynamic Constraint Checking v Auto-Flaat Dividend
v Reset Global Y ariables [ Fact Duplication

[ Sequence Expansion Operator Becognition

Cancel | k.

The Salience Evaluation pop-up menu allows the current salience evaluation behavior to be
changed (to either when-defined, when-activated, or every-cycle). The Strategy pop-up menu
allows the current conflict resolution strategy to be changed (to either depth, breadth, lex, mea,
complexity, simplicity, or random). The Static Constraint Checking, Dynamic Constraint
Checking, Reset Global Variables, Sequence Expansion Operator Recognition, Incremental
Reset, Auto-Float Dividend, and Fact Duplication check boxes are used to enable and disable
the named CLIPS option. Enabled options have a check in their check box while disabled items
have none. The Incremental Reset option cannot be changed if any defrules are currently
defined. Clicking the OK button exits the dialog and changes the CLIPS execution options
settings to those shown in the dialog. Clicking the Cancel button exits the dialog, but retains the
original settings of the CLIPS execution options before the dialog was entered.

This command is available when CLIPS is executing.
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2.4.6 Preferences...

This command displays a dialog box which allows the user to set the parameters for several
options in the CLIPS Windows interface.

Preferences

[v Command Completion Dialog

Step Rule Fiing [ncrement: |1

Cancel aF.
_Cancel |

Enable Warnings option determines whether certain warnings are issued. The default for this
option is on. When Warnings are enabled, certain commands chosen from the menu bar will
display a dialog box giving the user the option to abort the command. For example, executing a
clear command with Warnings enabled will display the following dialog box:

\‘1'?) OF. ta clear CLIPS environment?

Fies Mo |

Warnings will only be issued for commands chosen from the menu bar. For example, typing a
clear command directly into the dialog window and executing it will not display a warning
dialog box regardless of whether Warnings are enabled.

The Command Completion Dialog option determines whether a dialog is displayed to
determine which completion to use if more than one completion is available. The default for this
option is on. That is, a dialog will be displayed whenever there is more than one possible
completion. If this option is off, then a beep is sounded when no possible completion's exist.
From the CLIPS command prompt, the command set-completion-dialog can be used to enable
and disable the use of the completion dialog when there is more than one choice (pass the
symbol TRUE to enable the completion dialog and the symbol FALSE to disable it).

CLIPS Interfaces Guide 15



CLIPS Reference Manual

The Step Rule Firing Increment option determines how many rules will be executed when the
Step command (see Execution menu) is issued. Any integer between 1 and 999 inclusive can be
entered for this option. The default value for this option is 1.

This command is available when CLIPS is executing.

2.4.7 Clear CLIPS

This command is equivalent to the CLIPS command (clear). When this command is chosen, the
CLIPS command (clear) will be echoed to the dialog window and executed. If Warnings are
enabled, a dialog box will appear issuing a warning and providing an opportunity to cancel this
command. This command is not available when CLIPS is executing.

2.5 THE BROWSE MENU

Module k

Defrule Manager...
Deftactz Manager...
Deftemplate Manager...
Deffunction Manager ...
Defglobal Manager ...
Defgenerc Manager...
Defclass Manager...
Definztances Manager. ..
Agenda Manager...
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2.5.1 The Module Menu

[awizeg

Module 3 v BAIMN
Defrodule-4,
Defrule Manager...
Defrmodule-B
Deftactz Manager...
Defrodule-C
Deftemplate Manager...
_ Defmodule-D
Deffunction Manager ...

Defglobal Manager ...
Defgenerc Manager...
Defclass Manager...
Definztances Manager. ..
Agenda Manager...

This menu displays a list of the defmodules currently defined in the CLIPS environment. A
check mark is displayed by the current module. Selecting a module from the menu list changes
the current module to the selected item.

2.5.2 Defrule Manager...

This command displays a dialog box which allows the defrules in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
performed on a defrule selected from the list of defrules currently in the knowledge base.
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Defrule Manager - 19 Items

‘defrule-d, Flamove
defrule-B —
defrule-C
defrule-0 Refresh
defrule-E

defrule-F M atches
defrule-G —
defrule-H
defrule-|
defrule-]
defrule-k.
defrule-L
defrule-M _
defrule-h [ Breakpoint

defrule-0 _
defrule-P [ Watch Activation
defrule-(

defrule-F [ watch Firings

defrule-5 J

Pprirt

Done

The Remove button will remove the currently selected defrule. Pressing this button is equivalent
to issuing an undefrule command. The Refresh button will refresh the currently selected
defrule. Pressing this button is equivalent to a refresh command. The Matches command will
list the matches for the currently selected defrule. Pressing this button is equivalent to a matches
command. The Pprint button will pretty print the currently selected defrule. Pressing this button
is equivalent to a ppdefrule command. Both the Matches and Pprint buttons echo the
equivalent CLIPS command and resulting output to the dialog window.

The Breakpoint check box is used to enable or disable a breakpoint on the currently selected
defrule. Rules with a breakpoint set have a check in their check box while rules without a
breakpoint have none. The Watch Activations check box is used to enable or disable the
messages that are printed when a rule is activated or deactivated. If the check box for a rule is
checked, then activation/deactivation messages for the rule will be printed. The Watch Firings
check box is used to enable or disable the messages that are printed when a rule is executed. If
the check box for a rule is checked, then execution messages for the rule will be printed.

Any number of operations can be executed from this dialog. When finished, click the Done

button to remove the dialog. The Defrule Manager... command is not available when CLIPS is
executing.
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2.5.3 Deffacts Manager...

This command displays a dialog box which allows the deffacts in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
performed on a deffacts selected from the list of deffacts currently in the knowledge base.

Deffactz Manager - 19 ltems

T ——— Bemove |
deffactz-B

deffacts-C
deffacts-D
deffacts-E
deffacts-F
deffactz-&G
deffacts-H
deffacts-|

deffacts-l

deffactz-F.
deffacts-L
deffactz-bd
deffacts-M
deffacts-0
deffacts-P
deffactz-0
deffactz-H

initial-fact =i

Pprirt

Done

The Remove button will remove the currently selected deffacts. Pressing this button is
equivalent to an undeffacts command The Pprint button will pretty print the currently selected
deffacts. Pressing this button is equivalent to a ppdeffacts command. The Pprint button echoes
the equivalent CLIPS command and resulting output to the dialog window. Any number of
operations can be executed from this dialog. When finished, click the Done button to remove the
dialog. The Deffacts Manager... command is not available when CLIPS is executing.

2.5.4 Deftemplate Manager...

This command displays a dialog box which allows the deftemplates in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
performed on a deftemplate selected from the list of deftemplates currently in the knowledge
base.
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Deftemplate Manager - 19 ltems

‘deftemplate-d, Remave |
deftemplate-B —
deftemplate-C
deftemplate-D
defternplate-E
deftemnplate-F
defternplate-G
deftemplate-H
deftemplate-|

deftemplate-]

defternplate-F.
deftemnplate-L
defternplate-hd
defternplate-M [ watch
deftemplate-0

deftemplate-F

defternplate-Ql

defternplate-R

initial-fact =i

Pprirt

Done

The Remove button will remove the currently selected deftemplate. Pressing this button is
equivalent to an undeftemplate command. The Pprint button will pretty print the currently
selected deftemplate. Pressing this button is equivalent to a ppdeftemplate command. The
Pprint button echoes the equivalent CLIPS command and resulting output to the dialog window.

The Watch check box is used to enable or disable the messages that are printed whenever a fact
is asserted or retracted. If the check box for a deftemplate is checked, then assert/retract
messages for facts associated with the deftemplate will be printed.

Any number of operations can be executed from this dialog. When finished, click the Done
button to remove the dialog. The Deftemplate Manager... command is not available when
CLIPS is executing.

2.5.5 Deffunction Manager...

This command displays a dialog box which allows the deffunctions in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
performed on a deffunction selected from the list of deffunctions currently in the knowledge
base.
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Deffunction Manager - 19 ltems

T — Bemove |
deffunction-B

deffunction-C
deffunction-D
deffunction-E
deffunction-F
deffunction-G
deffunction-H
deffunction-|
deffunction-
deffunction-k.
deffunction-L
deffunction-
deffunction-M [ watch
deffunction-0

deffunction-F

deffunction-Gl

deffunction-A

deffunction-5 J

Pprirt

Done

The Remove button will remove the currently selected deffunction. Pressing this button is
equivalent to an undeffunction command. The Pprint button will pretty print the currently
selected deffunction. Pressing this button is equivalent to a ppdeffunction command. The
Pprint button echoes the equivalent CLIPS command and resulting output to the dialog window.

The Watch check box is used to enable or disable the messages that are printed when a
deffunction begins and ends execution. If the check box for a deffunction is checked, then
execution messages for the deffunction will be printed.

Any number of operations can be executed from this dialog. When finished, click the Done
button to remove the dialog. The Deffunction Manager... command is not available when
CLIPS is executing.

2.5.6 Defglobals Manager...

This command displays a dialog box which allows the defglobals in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
performed on a defglobal selected from the list of defglobals currently in the knowledge base.
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Defglobal Manager - 19 Items

e E—— Bemove |
defglobal-B

defglobal-C

defglobal-D

defglobal-E

defglobal-F

defglobal-G

defglobal-H .
defalobal Eprint
defglobal-J

defglobal-k.

defglobal-L

defglobal-b4

defglobal-M

defglobal-0

defglobal-F

defglobal-Cl

defglobal-R

defglobal-5 =i

Done

The Remove button will remove the currently selected defglobal. Pressing this button is
equivalent to an undefglobal command. The Pprint button will pretty print the currently
selected defglobal. Pressing this button is equivalent to a ppdefglobal command. The Pprint
button echoes the equivalent CLIPS command and resulting output to the dialog window.

Any number of operations can be executed from this dialog. When finished, click the Done
button to remove the dialog. The Defglobals Manager... command is not available when CLIPS
is executing.

2.5.7 Defgeneric Manager...

This command displays a dialog box which allows the defgenerics in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
performed on a defgeneric selected from the list of defgenerics currently in the knowledge base.
Any number of operations can be executed from this dialog. When finished, click the Done
button to remove the dialog. The Defgeneric Manager... command is not available when CLIPS
is executing.
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Defgenenc Manager - 19 ltems

idefgeneric-4, Remove |
defgenenc-B
defgenenc-C
defgenernc-D
defgeneric-E
defagenenc-F
defgenernc-G
defgenenc-H
defgenernc:|
defgenernic-]
defgenernic-k. M ethods
defgenenc-L —
defgeneric-t
defgeneric-M [ watch
defgenenc-0

defgenernc-F

defgeneric-

defgenernic-H

defgenenc-5 J

Pprirt

Done

The Remove button will remove the currently selected defgeneric. Pressing this button is
equivalent to an undefgeneric command. The Pprint button will pretty print the currently
selected defgeneric. Pressing this button is equivalent to a ppdefgeneric command. The Pprint
button echoes the equivalent CLIPS command and resulting output to the dialog window.

The Watch check box is used to enable or disable the messages that are printed when a generic
function begins and ends execution. If the check box for a deffunction is checked, then execution
messages for the generic function will be printed.

The Methods... button displays a dialog box allowing the defmethods for the currently selected
defgeneric to be browsed. The dialog box that appears in response to this button allows an op-
eration to be performed on a defmethod selected from the list of defmethods currently in the
knowledge base.
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Defmethod-Handler Manager - B ltems [in precedence order]
M ethods for - <defgenernic-d:
TR AT Bemﬂve |
2 [INTEGER]
3 [SYMBOL) IMTEGER]
4 [S¥MBOL] [FLOAT]
5 [SYMBOL)
& [NUMEER]
7 [STRING] [INTEGER)
2 [STRING] Ppint
[ watch
| Dok

The Remove button will remove the currently selected defmethod. Pressing this button 1is
equivalent to an undefmethod command. The Pprint button will pretty print the currently
selected defmethod. Pressing this button is equivalent to a ppdefmethod command. The Pprint
button echoes the equivalent CLIPS command and resulting output to the dialog window.

The Watch check box is used to enable or disable the messages that are printed when a specific
method of a generic function begins and ends execution. If the check box for a defmethod is
checked, then execution messages for the method will be printed.

Any number of operations can be executed from this dialog. When finished, click the Done
button to return control to the Defgeneric Manager dialog box.

2.5.8 Defclass Manager...

This command displays a dialog box which allows the defclasses in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
performed on a defclass selected from the list of defclasses currently in the knowledge base. Any
number of operations can be executed from this dialog. When finished, click the Done button to
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remove the dialog. The Defclass Manager... command is not available when CLIPS is
executing.

Defclagz Manager - 19 ltems

ADDRESS | Bemove

idefclass-a
defclass-B -
ExTERNAL-ADDRESS Descrbe

FACT-ADDRESS

FLOAT Browse
[MITIAL-0BJECT
[MSTAMCE .
IMSTAMCE-ADDRESS Eprirt
[MSTAMCE-MNAME

INTEGER tzg. Handlers. ..
LE=EME
FMULTIFIELD
HMUMEBER
OBJECT
PRIMITIVE [ watch |nstances
STRIMG

SYMEOL [ ‘watch Slat Change

LSER =i

Done

The Remove button will remove the currently selected defclass. Pressing this button is
equivalent to an undefclass command. The Describe button will describe the currently selected
defclass. Pressing this button is equivalent to a describe-class command. The Browse command
displays the class hierarchy for the currently selected defclass. Pressing this button is equivalent
to a browse-class command. The Pprint button will pretty print the currently selected defclass.
Pressing this button is equivalent to a ppdefclass command. The Describe, Browse, and Pprint
buttons echo the equivalent CLIPS command and resulting output to the dialog window.

The Watch Instances check box is used to enable or disable the messages that are printed when
an instance is created or deleted. If the check box for a defclass is checked, then messages will be
printed whenever an instance of that class is created or deleted. The Watch Slots check box is
used to enable or disable the messages that are printed when an instance’s slot values are
changed. If the check box for a defclass is checked, then messages will be printed whenever an
instance of that class has a slot value changed.

The Message Handlers... button displays a dialog box allowing the message handlers for the
currently selected class to be browsed. The dialog box that appears in response to this button
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allows an operation to be performed on a defmessage-handler selected from the list of
defmessage-handlers currently in the knowledge base.

Defmeszage-Handler Manager - 19 ltems

Meszage Handler for - <defclazz-d

‘defmessage-handlerd [onmary| R emove |
defmeszage-handlerB [primary) —
defmeszage-handlerC [primary)
defmezzage-handlerD (primary)
defreszage-handlerk [primarn)
defmeszage-handlerF [prirnang)
defmeszage-handlerG (primary)
defmeszage-handlerH [primary)
defmeszage-handlerl [primary]

defrmezzage-handlern) [primary)

defreszage-handlerk. [primarn)
defmeszage-handlerl [prirnang)
defmeszage-handlert [primarny)
defmeszage-handlerM [primary) [ Watch
defmeszage-handlerd [primary)

defrmezzage-handlerP [primary]

defrmeszage-handlert) [prirmany)

defmeszage-handlerR [prinmarny)

defmeszage-handlers [primary) J

I Dorne

Pprint

The Remove button will remove the currently selected defmessage-handler. Pressing this button
is equivalent to an undefmessage-handler command. The Pprint button will pretty print the
currently selected defmessage-handler. Pressing this button is equivalent to a ppdefmessage-
handler command. The Pprint button echoes the equivalent CLIPS command and resulting
output to the dialog window.

The Watch check box is used to enable or disable the messages that are printed when a message-
handler begins and ends execution. If the check box for a defmessage-handler is checked, then

execution messages for the message-handler will be printed.

Any number of operations can be executed from this dialog. When finished, click the Done
button to return control to the Defclass Manager dialog box.
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2.5.9 Definstances Manager...

This command displays a dialog box which allows the definstances in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
performed on a definstances selected from the list of definstances currently in the knowledge
base.

Defhinstances Manager - 19 ltems

‘definzstances-o, Femove |
definstances-B —
definstances-C
definstances-D
definstances-E
defingtances-F
definstances-&
definstances-H
definstances-|
definstances-J
definstances-k.
defingtances-L
definstances-M

definstances-MN

definstances-0
definstances-P
definstances-0
defingtances-A

initial-object =i

Pprirt

Done

The Remove button will remove the currently selected definstances. Pressing this button is
equivalent to an undefinstances command. The Pprint button will pretty print the currently
selected definstances. Pressing this button is equivalent to a ppdefinstances command. The
Pprint button echoes the equivalent CLIPS command and resulting output to the dialog window.
Any number of operations can be executed from this dialog. When finished, click the Done
button to remove the dialog. The Definstances Manager... command is not available when
CLIPS is executing.

2.5.10 Agenda Manager...
This command displays a dialog box which allows the activation's on the agenda to be examined.

The dialog box that appears in response to this command allows any activation on the agenda to
be removed or fired.
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(1 defrule-3: [-0LF-7 Remove |
0 defrule-3; -2 f-7

0 defrule-3: -3.f-7

0 defrule-3; f-5.F-7

0 defrule-1; f-5.f-6

0 defrule-3; f-2.f-6

0 defrule-3: (5B

0 defrule-3: -5.f-4

0 defrule-2: -5

0 defrule-3; f-0.f-4 Fire |
0 defrule-3; f-2.f-4 -

0 defrule-3; f-3.f-4

0 defrule-3: 3.1

0 defrule-2: f-3

0 defrule-1: (2.1

0 defrule-3: 2.1

0 defrule-2; f-2

0 defrule-3: f-0.f-1

0 defrule-2: f-0 J Dione |

The Remove button will remove the currently selected activation from the agenda. The Fire
button will place the currently selected activation at the top of the agenda (regardless of its
salience). The dialog is then exited and the CLIPS command (run 1) will then be echoed to the
Dialog Window, causing the activation to fire. Any number of remove operations (except the
Fire button) can be executed from this dialog. When finished, click the Done button to remove
the dialog. The Agenda Manager... command is not available when CLIPS is executing.
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2.6 THE WINDOW MENU

Window

LCazcade

Tile Harizontally
Tile Vertically
Clogze Al

Show Status Windows

Hide Statuz “Windows

Tile Dialog & Statug Windows
Clear Dialog Window

1 Facts Window
2 figenda Window
3 Instances \Window
4 [Globalz \Window
5 Focuz Windaw

v b Dialog *findow

2.6.1 Cascade

Arranges windows as overlapped tiles.

2.6.2 Tile Horizontally

Arranges windows as non-overlapping tiles from top to bottom.

2.6.3 Tile Vertically

Arranges windows as non-overlapping tiles from left to right.

2.6.4 Close All

Closes all status and edit windows.
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2.6.5 Show Status Windows

This command displays the Facts Window, Agenda Window, Instances Window, Globals
Window, and Focus Window (creating them if they do not already exist). This command is
available when CLIPS is executing.

2.6.6 Hide Status Windows

This command conceals the Facts Window, Agenda Window, Instances Window, Globals
Window, and Focus Window. This command is available when CLIPS is executing.

2.6.7 Tile Dialog & Status Windows

Arranges the dialog and status windows as non-overlapping tiles.

2.6.8 Clear Dialog Window

This command clears all of the text in the Dialog Window. From the CLIPS command prompt,
the command clear-window (which takes no arguments) will also clear all of the text in the
Dialog Window. This command is available when CLIPS is executing.

2.6.9 Facts Window

This command displays the Facts Window if it is not already visible, otherwise it brings the
window to the front. The Facts Window displays the list and number of facts in the fact-list. A
check mark is placed by the window name if it is the front-most window. This command is
available when CLIPS is executing.

2.6.10 Agenda Window

This command displays the Agenda Window if it is not already visible, otherwise it brings the
window to the front. The Agenda Window displays the list of activation's currently on the
agenda. A check mark is placed by the window name if it is the front-most window. This
command is available when CLIPS is executing.

2.6.11 Instances Window

This command displays the Instances Window if it is not already visible, otherwise it brings the
window to the front. The Instances Window displays the list of existing instances and their slot
values. A check mark is placed by the window name if it is the front-most window. This
command is available when CLIPS is executing.
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2.6.12 Globals Window

This command displays the Globals Window if it is not already visible, otherwise it brings the
window to the front. The Globals Window displays the list of global variables and their current
values. A check mark is placed by the window name if it is the front-most window. This
command is available when CLIPS is executing.

2.6.13 Focus Window

This command displays the Focus Window if it is not already visible, otherwise it brings the
window to the front. The Focus Window displays the current focus stack. A check mark is
placed by the window name if it is the front-most window. This command is available when
CLIPS is executing.

2.6.14 Dialog Window

This command brings the Display Window to the front. A check mark is placed by the window
name if it is the front-most window. This command is available when CLIPS is executing.

2.6.15 Edit Windows

The list of open editing windows is displayed after the list of status and dialog windows.
Selecting an editing window brings the window to the front. A check mark is placed by the
editing window name if it is the front-most window.

2.7 THE HELP MENU

About CLIPS...
CLIPS Help...

Cornmand Complete...  Chl+]
v Statusg Line

2.7.1 About CLIPS

This command displays version information about CLIPS. Click the OK button to continue. This
command is available when CLIPS is executing.
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2.7.2 CLIPS Help

This command displays the CLIPS hypertext help information. This command is equivalent to
the CLIPS command (winhelp <topic-name>) or (winhelp). This command is available when
CLIPS is executing. For more information see the Microsoft Windows User's Guide on using

help.

2.7.3 Complete... (Ctrl+]J)

This command “completes” the symbol currently being entered in the display window. In the
display window, the symbol to be completed is always the last symbol in the display window
(the current selection has no effect). If no possible completion's exist, a beep is sounded. If only
one possible completion exists (e.g. “deftemplat” for “deftemplate”), then the symbol is
automatically completed. If more than one completion exists, a dialog is displayed showing all
possible completion's (or optionally a beep is sounded — See section 2.3.6).

The following dialog shows the possible completion's for the symbol “get-":

Command Completion for "get-" -

‘net-auto-float-dividend

get-current-module
get-defclazsz-lizt

get-deffactz-lizt
get-deffunction-list
get-defgenenc-lst
get-defglobal-list
get-definstances-list
get-defmeszzage-handler-list
get-defmethod-lizt
get-defmodule-list

get-defrule-list
get-deftemplate-list
get-dynamic-conzstraint-checking
get-fact-duplication

qet-fact-list

get-focusz

get-focus-stack

get-function-lzt j

29 Items

LCancel

Click the OK button to complete the symbol with the current selection. Click the Cancel button
to terminate the dialog without any command completion. Note that symbols defined by the user
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(as part of a construct or a CLIPS data structure such as a fact or instance) will also be listed for
command completion. This command is not available when CLIPS is executing.

Click the Help button to obtain hypertext information about the current selection. Note that some
of the selections do not have an associated help entry, in this event, the help system will return a

topic not found error. For more information about help see Section 2.6.2.

2.8 CREATING THE WINDOWS 95/98/NT EXECUTABLES

2.8.1 Building the CLIPS Interface Executable Using Microsoft Visual C++ 6.0

The following steps describe how to create the Windows 95/98/NT machine specific version of
CLIPS using Microsoft Visual C++ 6.0:

1) The following source files are needed to build the interface in addition to the source files for
the standard CLIPS executable:

Balance.h
Edit.h
Frame.h
MDICLIPS.h
Registry.h
StdSDK.h

Balance.c
Edit.c
Initialization.c
Menucmds.c
Status.c

CLIPSedit.ico
query.cur
2.cur

6.cur

Dialogl.h
EditUtil.h
Initialization.h
Menu.h
Resource.h
Text.h

Dialogl.c

EditUtil.c
MainFrameToolbar.c
Print.c

Text.c

clipswin.ico
ToolBar.bmp
3.cur

7.cur

Dialog2.h
Extensions.h
MainFrameToolbar.h
Menucmds.h
Search.h

Dialog2.c
FindWnd.c
MDI.c
Registry.c
WinMain.c

CLIPSwinc.ico
wait.cur

4.cur

8.cur

Display.h
FindWnd.h
MDI.h
Print.h
Status.h

Display.c
Frame.c
Menu.c
Search.c

MDICLIPS.rc
1.cur
5.cur
9.cur

2) Create the directory path C:\CLIPS\MVC. Place the CLIPSwin.dsw, CLIPSWin.dsp,
CLIPS.dsp, and CLIPSWin.opt files in the MVC directory.

3) Create a sub-directory named Source in the MV C directory. Create a sub-directory named
CLIPS in the Source directory. Copy all of the CLIPS source code into the CLIPS

directory.
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4) Create a sub-directory named Interface in the SOURCE directory. Copy the Windows
interface source code (the files listed in step 1) into the INTRFACE directory.

5) Launch the Microsoft Visual C++ application by double clicking on CLIPSwin.dsw file.

6) Edit the setup.h file. Set the compiler directive flag IBM_MSC to 1 and the compiler
directive flag WINDOW _INTERFACE to 1.

7) Select the Set Active Configuration... menu item in the Build Menu and then select
CLIPSWin — Win32 Release.

8) Under the Build Menu choose Rebuild all. The CLIPSWin.exe executable will be placed
in the MVC directory.

2.8.2 Building the CLIPS Console Executable Using Microsoft Visual C++ 6.0

The following steps describe how to create the Windows 95/98/NT console version of CLIPS
using Microsoft Visual C++ 6.0:

1) Follow steps 1 through 6 in section 2.8.1.

2) Select the Set Active Configuration... menu item in the Build Menu and then select CLIPS
— Win32 Release.

3) Under the Build Menu choose Rebuild all. The CLIPS.exe executable will be placed in the
MVC directory.
2.8.3 Building the CLIPS Interface Executable Using Borland C++ 5.0

The following steps describe how to create the Windows 95/98/NT machine specific version of
CLIPS using Borland C++ 5.0:

1) The source files used in step 1 in section 2.8.1 are also needed for building the Borland C++
version.

2) Create the directory path C:\CLIPS\BLC. Place the CLIPSWin.ide file in the BL C
directory.

3) Create a sub-directory named Source in the BLC directory. Create a sub-directory named
CLIPS in the Source directory. Copy all of the CLIPS source code into the CLIPS

directory.
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4) Create a sub-directory named Interface in the Source directory. Copy the Windows
interface source code (the files listed in step 1) into the Interface directory.

5) Create a sub-directory named Objects in the Source directory.
6) Launch the Borland C++ application. Open the CLIPSwin.ide project.

7) Edit the setup.h file. Set the compiler directive flag IBM_TBC to 1 and the compiler
directive flag WINDOW _INTERFACE to 1.

8) Select the Project... menu item in the Options Menu and then select Directories. Replace
the C:\BCS\INCLUDE and C:\BCS5\LIB directory paths with the appropriate paths for
your installation of Borland C++.

9) Under the Project Menu choose Build all. The CLIPSWin.exe executable will be placed in
the BLC directory.

2.8.4 Building the CLIPS Interface Executable Using Metrowerks CodeWarrior PR4

The following steps describe how to create the Windows 95/98/NT machine specific version of
CLIPS using Metrowerks CodeWarrior Professional Release 4:

1) The source files used in step 1 in section 2.8.1 are also needed for building the CodeWarrior
version.

2) Create the directory path C:\CLIPS\MCW. Place the CLIPSWin.mcp file in the MCW
directory.

3) Create a sub-directory named Source in the MCW directory. Create a sub-directory named
CLIPS in the Source directory. Copy all of the CLIPS source code into the CLIPS

directory.

4) Create a sub-directory named Interface in the Source directory. Copy the Windows
interface source code (the files listed in step 1) into the Interface directory.

5) Launch the CodeWarrior application. Open the CLIPSwin.mcp project.

6) Edit the setup.h file. Set the compiler directive flag IBM_MCW to 1 and the compiler
directive flag WINDOW _INTERFACE to 1.

7) Under the Project menu, select Set Current Target and choose CLIPSWin.
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8) Under the Project Menu choose Make. The CLIPSWin.exe executable will be placed in
the MCW directory.

2.8.5 Building the CLIPS Console Executable Using Metrowerks CodeWarrior PR4

The following steps describe how to create the Windows 95/98/NT console version of CLIPS
using CodeWarrior Professional Release 4:

1) Follow steps 1 through 6 in section 2.8.4.
2) Under the Project menu, select Set Current Target and choose CLIPS.

3) Under the Project Menu choose Make. The CLIP.exe executable will be placed in the
MCW directory.
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Section 3 - CLIPS Macintosh Interface

This section provides a brief summary of each menu command found in the CLIPS 6.2
Macintosh interface. The menus are listed in the left to right order in which they appear in the
menu bar. The commands within each menu are also listed in the order in which they appear in
the menu.

The rest of the CLIPS 6.2 Macintosh interface is straightforward, following Macintosh interface
standards. Commands can be entered directly in the dialog window in a fashion similar to the
standard CLIPS command line interface. The integrated editor is implemented in a fashion
similar to that of other Macintosh editors.

If rules are not being executed, then execution of the current command or CLIPS program can be
halted by holding down the 3 key while pressing the period key. If rules are being executed, then
rule execution can be interrupted on a rule firing boundary by holding down the 3 key while
pressing the period key. Holding down the shift key, the 3 key, and the period key will halt rule
execution after the current RHS action.

Some menu commands are available while CLIPS is executing a user program. Among these
commands are the Options... menu item, the Watch... menu item, the Turn Dribble On.../Turn
Dribble Off menu item, and all menu items in Window menu. The command summary for each
menu item indicates whether it is available while CLIPS is executing. In addition, windows may
be moved and resized while CLIPS is executing.

The bottom left-hand corner of the dialog window contains two drag and drop areas as show
below. Dropping text into the Compile area loads the text into the CLIPS knowledge base. This
is essentially equivalent to selecting text in an edit window and choosing the Load Selection
menu item. Dropping text into the Batch area treats the text as if it were a batch file and executes
it as a series of commands. This is essentially equivalent to selecting text in an edit window and
choosing the Batch Selection menu item.

Compile 4}| Batch & |« )

The bottom left-hand corner of an edit window contains a pop-up menu control as show below.

Constructs b A 'D
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Clicking in the pop-up menu control displays a menu containing the list of constructs found in
the edit window. Selecting one of the constructs in the menu will position the construct in the
edit window so that it is visible.

defrule rule-1
deffacts facts-1
deftemplaote template-1
deffunction function-1
defrule rule-2

i defrule rule-3 I

3.1 THE FILE MENU
Mew #EN
Open... %0
Load... 3L

Load Batch...
Load Binary...
Turn Dribble On...

Close EW
Save #S
Save As...

Save Binary...

Revert

Page Setup...
Print... &P

38 Section 3 - CLIPS Macintosh Interface



CLIPS Reference Manual

3.1.1 New (3N)

This command opens a new buffer for editing with the window name untitled. This command is
not available when CLIPS is executing.

3.1.2 Open... (®8O0)

This command displays the standard file selection dialog box, allowing the user to select a text
file to be opened as a buffer for editing. More than one file can be opened at the same time,
however, the same file cannot be opened more than once. As files are opened, they are
automatically stacked. This command is not available when CLIPS is executing.

3.1.3 Load... (¥L)

This command displays the standard file selection dialog box, allowing the user to select a text
file to be loaded into the knowledge base. This command is equivalent to the CLIPS command
(load <file-name>). When this command is chosen and a file is selected, the appropriate CLIPS
load command will be echoed to the dialog window and executed. This command is not available
when CLIPS is executing.

3.1.4 Load Batch...

This command displays the standard file selection dialog box, allowing the user to select a text
file to be executed as a batch file. This command is equivalent to the CLIPS command (batch
<file-name>). When this command is chosen and a file is selected, the appropriate CLIPS batch
command will be echoed to the dialog window and executed. This command is not available
when CLIPS is executing.

3.1.5 Load Binary...

This command displays the standard file selection dialog box, allowing the user to select a file to
be loaded as a binary image. This command is equivalent to the CLIPS command (bload <file-
name>). When this command is chosen and a file is selected, the appropriate CLIPS bload
command will be echoed to the dialog window and executed. This command is not available
when CLIPS is executing.

3.1.6 Turn Dribble On...

This command displays the standard file selection dialog box, allowing the user to select a text
file in which subsequent display window output will be stored. This command is equivalent to
the CLIPS command (dribble-on <file-name>). When this command is chosen and a file is
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selected, the appropriate CLIPS dribble-on command will be echoed to the dialog window and
executed. While the dribble file is active, this menu item will be modified to read Turn Dribble
Off. Selecting the menu item at this time will close the dribble text file. The Turn Dribble Off
command is equivalent to the CLIPS command (dribble-off). This command is available when
CLIPS is executing (however the commands will not be echoed to the dialog window).

3.1.7 Close (W)

This command closes the active window if it has a go-away box in its upper left corner. If the
active window is an editing buffer that has been modified since it was last saved, a dialog box
will confirm whether the changes should be saved or discarded or whether the close command
should be canceled. This command is available when CLIPS is executing. This command is
available when CLIPS is executing.

3.1.8 Save (#&S)

This command saves the file in the active edit window. If the file is untitled, a dialog box will
prompt for a file name under which to save the file. The Batch File option in the standard file
dialog box determines whether a file is saved as a batch file or a text file. CLIPS batch file
documents are executed as a series of commands when launched, whereas CLIPS text file
documents are placed in an editing buffer when launched. Both types of documents can be edited
as text files in a CLIPS editing buffer. This command is available when CLIPS is executing.

3.1.9 Save As...

This command allows the active edit window to be saved under a new name. A dialog box will
appear to prompt for the new file name. The name of the editing window will be changed to the
new file name. This command is available when CLIPS is executing.

3.1.10 Save Binary...

This command allows the constructs currently stored in CLIPS to be saved as a binary image. A
dialog box will appear to prompt for the new file name in which to store the binary image. This
command is equivalent to the CLIPS command (bsave <file-name>). When this command is
chosen and a file is selected, the appropriate CLIPS bsave command will be echoed to the dialog
window and executed. This command is not available when CLIPS is executing.
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3.1.11 Revert

This command restores the active edit window to the last-saved version of the file in the buffer.
Any changes made since the file was last saved will be discarded. This command is available
when CLIPS is executing.

3.1.12 Page Setup...

This command allows the user to specify information about the size of paper used by the printer.
This command is available when CLIPS is executing.

3.1.13 Print...

This command allows the user to print the active edit window. This command is available when
CLIPS is executing.

3.2 THE EDIT MENU
= .

Undo ®7
Cut E
Copy 6 C
Paste kAT
Clear

Select All HEA
Complete... )
Balance 3B
Comment E

Uncomment U

Set Font...
Clear Window

Preferences...
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3.2.1 Undo (EZ)

This command allows you to undo your last editing operation. Typing, cut, copy, paste, and clear
operations can all be undone. The Undo menu item will change in the Edit menu to reflect the
last operation performed. For example, if a Paste command was just performed, the Undo menu
item will read Undo Paste. If the Paste command is undone, the menu item will read Redo
Paste. This command is not available when CLIPS is executing.

3.2.2 Cut (¥#X)

This command removes selected text in the active edit window and places it in the Clipboard.
This command is not available when CLIPS is executing.

3.2.3 Copy (&C)

This command copies selected text in the active edit window or the display window and places it
in the Clipboard. This command is not available when CLIPS is executing.

3.2.4 Paste (3BV)

This command copies the contents of the Clipboard to the selection point in the active edit
window or the display window. If selected text is in the active edit window, it is replaced by the
contents of the Clipboard. Pasted text to the display window is always placed at the end of the
display window regardless of whether there is selected text. This command is not available when
CLIPS is executing.

3.2.5 Clear
This command removes selected text in the active edit window. The selected text is not placed in
the Clipboard. This command is not available when CLIPS is executing.

3.2.6 Select All (JEA)

This command selects all of the text in the active edit or display window.

3.2.7 Complete... (38))

This command “completes” the symbol currently being entered in the display window or the
active edit window. In the display window, the symbol to be completed is always the last symbol
in the display window (the current selection has no effect). In an edit window, the symbol being
completed is the current selection, or if no selection exists, the symbol to the left of the current
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insertion point. If no possible completions exist, a beep is sounded. If only one possible
completion exists (e.g. “deftemplat” for “deftemplate”), then the symbol is automatically
completed. If more than one completion exists, a dialog is displayed showing all possible
completions (or optionally a beep is sounded—See section 3.3.10). The following dialog shows
the possible completions for the symbol “set-s™:

Command Completions

set-s - 4 ltems

set-salience-evaluation
sef-sequUence-operator-recognition
set-static-constraint-checking
set-strategy

" Cancel

o

Click the OK button to complete the symbol with the current selection. Click the Cancel button
to terminate the dialog without any command completion. Note that symbols defined by the user
(as part of a construct or a CLIPS data structure such as a fact or instance) will also be listed for
command completion. This command is not available when CLIPS is executing.

3.2.8 Balance (3£B)

This command operates on the current selection in the active edit window by attempting to find
the smallest selection containing the current selection which has balanced parentheses. Repeat-
edly using this command will select larger and larger selections of text until a balanced selection
cannot be found. The balance command is a purely textual operation and can be confused by
parentheses found in strings. This command is not available when CLIPS is executing.
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3.2.9 Comment (38;)

This command operates on the current selection in the active edit window by adding a semicolon
to the beginning of each line contained in the selection.

3.2.10 Uncomment (3&U)

This command operates on the current selection in the active edit window by removing a
semicolon (if one exists) from the beginning of each line contained in the selection.

3.2.11 Set Font...

This command allows the font used in the currently active editing buffer to be changed. When
you use this command, the following dialog will appear:

Set Font
Font: Monaco ? F ok M
Size: 9 T‘ Cancel

The quick brown fox jumped ower the lazy dogs

Select a font and font size from the popup menus on the left of the dialog. The sentence at the
bottom of the dialog will be displayed using the selected font. Click the OK button to change the
font used in the currently active editing buffer. Click the Cancel button to retain the current font
setting. This command is not available when CLIPS is executing.

3.2.12 Clear Window

This command clears all of the text in the dialog window. From the CLIPS command prompt, the
command clear-window (which takes no arguments) will also clear all of the text in the dialog
window. This command is available when CLIPS is executing.
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3.2.13 Preferences...

This command displays a dialog box which allows the user to set the parameters for several
options in the CLIPS Macintosh interface.

Preferences

E Enable Warnings
E Command Completion Dialog

Remember
E Edit Window 5tate
f Environment Window 5tate

Honor
f Edit Window State
i‘ Environment Window State

“ Cancel f‘ OK "‘

The Command Completion Dialog option determines whether a dialog is displayed to
determine which completion to use if more than one completion is available. The default for this
option is on. That is, a dialog will be displayed whenever there is more than one possible
completion. If this option is off, then a beep is sounded when no possible completions exist.
From the CLIPS command prompt, the command set-completion-dialog can be used to enable
and disable the use of the completion dialog when there is more than one choice (pass the
symbol TRUE to enable the completion dialog and the symbol FALSE to disable it).

The Remember Edit Window State option determines whether the window position, font, and
current selection of an edit window are saved in addition to text changes when an edit window is
saved. The Remember Environment Window State option determines whether the window
position of the Display Window, Facts Window, Agenda Window, Instances Window,
Globals Window, or Focus Window is saved when the window is closed.

The Honor Edit Window State option determines whether the saved window position, font, and

current selection of an edit window are used when a file is opened. The Honor Environment
Window State option determines whether the saved window position of the Display Window,
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Facts Window, Agenda Window, Instances Window, Globals Window, or Focus Window is
used when the window is opened.

This command is available when CLIPS is executing.

3.3 THE BUFFER MENU
i Buffer _

Find... F#EF
Find Again #0
Find Selection #H
Enter Find String SE
Replace =
Replace & Find Again 3T
Replace All

Load Selection HK
Batch Selection #M

Load Buffer

3.3.1 Find... (3%&F)
This command displays a dialog box which allows the user to set parameters for text search and

replacement operations. The dialog box that appears allows a search and replacement string to be
specified.
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Search for:

Replace with:

1 Match Words e -, ———
# Ignore Case t Find —’ Don’t Find Cancel

Two other options can be set in the search dialog box. The Match Words option will only allow
a string search to match whole words; that is, the string “at” would not be bound in the string
“match”. The default for this setting is off. The Ignore Case option makes the string search
operation case-insensitive for alphabetic characters; that is, the string “Upper” will match the
string “uPPER”. The default for this setting is on.

Once search options have been set, one of three search dialog buttons can be pressed. The Find
button will search for the first occurrence of the Search For string in the active edit window
starting at the end of the current selection and preceding to the end of the buffer. The Don’t Find
button saves the search and replace strings and options but does not initiate a search. The Cancel
button aborts the find command. The search and replace strings and options are restored to the
values they had before the dialog box was entered.

This command is not available when CLIPS is executing.

3.3.2 Find Again (8G)

This command searches for the next occurrence of the Search For string starting at the end of
the current selection and preceding to the end of the buffer. This command is not available when
CLIPS is executing.

3.3.3 Find Selection (38H)

This command sets the Search For string to the current selection in the edit window and then
searches for that string. It is equivalent to a Enter Find String command followed by a Find
Again command. This command is not available when CLIPS is executing.
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3.3.4 Enter Find String (JE)

This command sets the Search For string to the current selection in the edit window. This
command is not available when CLIPS is executing.

3.3.5 Replace (3=)

This command will replace the current selection in the active edit window with the Replace
With string. If no selection exists, the Replace With string will be inserted at the current
insertion point in the active edit window. The Replace With string may be left empty to replace
text with nothing. This command is not available when CLIPS is executing.

3.3.6 Replace and Find Again (3T)

This command is equivalent to executing a Replace command followed by a Find Again
command. This command is not available when CLIPS is executing.

3.3.7 Replace All

This command is equivalent to executing a Find Again command followed by a Replace
command repeatedly until the Find Again command does not find the Search For string. This
command is not available when CLIPS is executing.

3.3.8 Load Selection (K)

This command loads the current selection in the active edit window into the CLIPS knowledge
base. Standard error detection and recovery routines used to load constructs from a file are also
used when loading a selection (i.e., if a construct has an error in it, the rest of the construct will
be skipped over until another construct to be loaded is found). This command is not available
when CLIPS is executing.

3.3.9 Batch Selection (M)

This command treats the current selection in the active edit window as if it were a batch file and
executes it as a series of commands. Standard error detection and recovery routines used to load
construct from a file are notr used when batching a selection (i.e., if a construct has an error in it,
a number of ancillary errors may be generated by subsequent parts of the same construct
following the error). This command is not available when CLIPS is executing.
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3.3.10 Load Buffer
This command loads the contents of the active edit window into the CLIPS knowledge base. It is

equivalent to selecting the entire buffer and executing a Load Selection command. This
command is not available when CLIPS is executing.

3.4 THE COMMANDS MENU

Watch...
Options...

Set Commands. ..

(clear) #E1
(agenda) 32
(facts) 383
(instances) #4

(show-defglobals) 385
(list-focus-stack) 386
(browse-classes) 87

ireset) FEE

(run) 39

(run 1) 30
3.4.1 Watch...

This command displays a dialog box which allows the user to set various watch items as enabled
or disabled.
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Watch
-‘ﬂ Compilations | Deffunctions
[ Facts "1 Generic Functions
"1 Rules "1 Methods
[ Statistics " llInstances
"] Activations [ slots
"1 Focus ] Message-handlers
"1 Globals ] Messages
F il i F il b
All None

“ cancel oK

" Use As Default

Watch items can be enabled or disabled by clicking the appropriate check box. Enabled watch
items have a check in their check box. Disabled watch items have no check mark in their check
box. Pressing the All button checks all of the watch item check boxes. Pressing the None button
unchecks all of the watch item check boxes. Clicking the OK button exits the dialog and changes
the current watch settings to those shown in the dialog. Clicking the Cancel button exits the
dialog, but retains the original settings of the watch items before the dialog was entered. Clicking
the Use As Default button saves the current settings in the CLIPS preferences file. These settings
will be restored the next time the CLIPS application is launched.

This command is available when CLIPS is executing.

3.4.2 Options...

This command displays a dialog box which allows the user to set various CLIPS execution
options.
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Execution Options

Salience Evaluation: When Defined ?

Strategy: Depth ?
‘E Static Constraint Checking ‘E Incremental Reset
| Dynamic Constraint Checking @Aum—Flﬂat Dividend
i‘ Reset Global Variables " Fact Duplication

| sequence Expansion QOperator Recognition

Cancel f oK 3

“ Use As Default

The Salience Evaluation pop-up menu allows the current salience evaluation behavior to be
changed (to either when-defined, when-activated, or every-cycle). The Strategy pop-up menu
allows the current conflict resolution strategy to be changed (to either depth, breadth, lex, mea,
complexity, simplicity, or random). The Static Constraint Checking, Dynamic Constraint
Checking, Reset Global Variables, Sequence Expansion Operator Recognition, Incremental
Reset, Auto-Float Dividend, and Fact Duplication check boxes are used to enable and disable
the named CLIPS option. Enabled options have a check in their check box while disabled items
have none. The Incremental Reset option cannot be changed if any defrules are currently
defined. Clicking the OK button exits the dialog and changes the CLIPS execution options
settings to those shown in the dialog. Clicking the Cancel button exits the dialog, but retains the
original settings of the CLIPS execution options before the dialog was entered. Clicking the Use
As Default button saves the current settings in the CLIPS preferences file. These settings will be
restored the next time the CLIPS application is launched.

This command is available when CLIPS is executing.

3.4.3 Set Commands...

This command displays a dialog box which allows the user to define ten “short cut” commands.
These commands are accessed using command keys O through 9.
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Commands
21 | (clear) I #b (list-focus-stack)
32 (agenda) #7 (browse-classes)
#£3 (facts) #E  (reset)
#£4  (instances) #£9  (run)
#5 (show-defglobals) #0 (runl)

’ Cancel " f—ﬂ!—’

F Use As Default

To change a command short cut, enter the new command in the text field to the left of the desired
command key. Clicking the OK button exits the dialog and changes the command short cut
settings to those shown in the dialog. Clicking the Cancel button exits the dialog, but retains the
original settings of the command short cuts before the dialog was entered. Clicking the Use As
Default button saves the current settings in the CLIPS preferences file. These settings will be
restored the next time the CLIPS application is launched.

The current settings for the command short cuts are shown beneath the Set Commands... menu
item in the Commands menu.

This command is available when CLIPS is executing.
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3.5 THE BROWSE MENU

Module >

Defrule Manager...
Deffacts Manager...
Deftemplate Manager...
Deffunction Manager...
Defglobal Manager...
Defgeneric Manager...
Defclass Manager...
Definstances Manager...
Agenda Manager...

3.5.1 The Module Menu

Browse
Maodule L v MAIN o

MODULE-A
e T
getr... MODULE-C

Deftemplate Manager...
Deffunction Manager...
Defglobal Manager...
Defgeneric Manager...
Defclass Manager...
Definstances Manager...
Agenda Manager...
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This menu displays a list of the defmodules currently defined in the CLIPS environment. A
check mark is displayed by the current module. Selecting a module from the menu list changes
the current module to the selected item.

3.5.2 Defrule Manager...

This command displays a dialog box which allows the defrules in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
performed on a defrule selected from the list of defrules currently in the knowledge base.

Defrule Manager

13 ltems
defrula-A “ Remove
defrule-E —
defrule-C Refresh
defrule-D g
defrule-E Matches
defrule-F o
defrule-G Pprint
defrule-H __| Breakpoint
defrule-I
defrule-] "] Watch Activations
defrule-K - ..

| Watch F
defrule-L i ratch Firings
defrule-m f Done ‘

The Remove button will remove the currently selected defrule. Pressing this button is equivalent
to issuing an undefrule command. The Refresh button will refresh the currently selected
defrule. Pressing this button is equivalent to a refresh command. The Matches command will
list the matches for the currently selected defrule. Pressing this button is equivalent to a matches
command. The Pprint button will pretty print the currently selected defrule. Pressing this button
is equivalent to a ppdefrule command. Both the Matches and Pprint buttons echo the
equivalent CLIPS command and resulting output to the dialog window.

The Breakpoint check box is used to enable or disable a breakpoint on the currently selected
defrule. Rules with a breakpoint set have a check in their check box while rules without a
breakpoint have none. The Watch Activations check box is used to enable or disable the
messages that are printed when a rule is activated or deactivated. If the check box for a rule is
checked, then activation/deactivation messages for the rule will be printed. The Watch Firings
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check box is used to enable or disable the messages that are printed when a rule is executed. If
the check box for a rule is checked, then execution messages for the rule will be printed.

Any number of operations can be executed from this dialog. When finished, click the Done
button to remove the dialog. The Defrule Manager... command is not available when CLIPS is
executing.

3.5.3 Deffacts Manager...

This command displays a dialog box which allows the deffacts in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
performed on a deffacts selected from the list of deffacts currently in the knowledge base.

Deffacts Manager

13 ltems

deffacts-A Faemove 3
deffacts-B ——
deffacts-C
deffacts-D
deffacts-E
deffacts-F
deffacts-C ~ Pprint
deffacts-H T
deffacts-|
deffacts-|
deffacts-K

deffacts-L
deffacts-M f Done ©

The Remove button will remove the currently selected deffacts. Pressing this button is
equivalent to an undeffacts command The Pprint button will pretty print the currently selected
deffacts. Pressing this button is equivalent to a ppdeffacts command. The Pprint button echoes
the equivalent CLIPS command and resulting output to the dialog window. Any number of
operations can be executed from this dialog. When finished, click the Done button to remove the
dialog. The Deffacts Manager... command is not available when CLIPS is executing.
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3.5.4 Deftemplate Manager...

This command displays a dialog box which allows the deftemplates in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
performed on a deftemplate selected from the list of deftemplates currently in the knowledge
base.

Deftemplate Manager

13 ltems

cdefremplate-A - y—
deftemplate-E —_—
deftemplate-C

deftemplate-D S
deftemplate-E Pprint

deftemplate-F
deftemplate-G
deftemplate-H
deftemplate-| ] Watch
deftemplate-]
deftemplate-K
deftemplate-L

deftemplate-h %

The Remove button will remove the currently selected deftemplate. Pressing this button is
equivalent to an undeftemplate command. The Pprint button will pretty print the currently
selected deftemplate. Pressing this button is equivalent to a ppdeftemplate command. The
Pprint button echoes the equivalent CLIPS command and resulting output to the dialog window.

The Watch check box is used to enable or disable the messages that are printed whenever a fact
is asserted or retracted. If the check box for a deftemplate is checked, then assert/retract
messages for facts associated with the deftemplate will be printed.

Any number of operations can be executed from this dialog. When finished, click the Done

button to remove the dialog. The Deftemplate Manager... command is not available when
CLIPS is executing.
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3.5.5 Deffunction Manager...

This command displays a dialog box which allows the deffunctions in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
performed on a deffunction selected from the list of deffunctions currently in the knowledge
base.

Deffunction Manager

13 ltems

deffunction-A w
deffunction-B —
deffunction-C

deffunction-D

deffunction-E " Pprint

deffunction-F
deffunction-G
deffunction-H
deffunction-I| ] watch
deffunction-]
deffunction-K
deffunction-L

deffunction-M F Done :’

The Remove button will remove the currently selected deffunction. Pressing this button is
equivalent to an undeffunction command. The Pprint button will pretty print the currently
selected deffunction. Pressing this button is equivalent to a ppdeffunction command. The
Pprint button echoes the equivalent CLIPS command and resulting output to the dialog window.

The Watch check box is used to enable or disable the messages that are printed when a
deffunction begins and ends execution. If the check box for a deffunction is checked, then
execution messages for the deffunction will be printed.

Any number of operations can be executed from this dialog. When finished, click the Done

button to remove the dialog. The Deffunction Manager... command is not available when
CLIPS is executing.
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3.5.6 Defglobal Manager...

This command displays a dialog box which allows the defglobals in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
performed on a defglobal selected from the list of defglobals currently in the knowledge base.

Defglobal Manager

13 ltems

defglobal-B —
defglobal-C

defglobal-D S
defglobal-E Pprint
defglobal -F

defglobal -G

defglobal-H

defglobal-| ] Watch
defglobal-]

defglobal-K

defglobal-L

defglobal -M f Done

The Remove button will remove the currently selected defglobal. Pressing this button is
equivalent to an undefglobal command. The Pprint button will pretty print the currently
selected defglobal. Pressing this button is equivalent to a ppdefglobal command. The Pprint
button echoes the equivalent CLIPS command and resulting output to the dialog window.

The Watch check box is used to enable or disable the messages that are printed when the value
of a global variable is changed. If the check box for a defglobal is checked, then value change
messages will be printed.

Any number of operations can be executed from this dialog. When finished, click the Done

button to remove the dialog. The Defglobal Manager... command is not available when CLIPS
is executing.
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3.5.7 Defgeneric Manager...

This command displays a dialog box which allows the defgenerics in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
performed on a defgeneric selected from the list of defgenerics currently in the knowledge base.
Any number of operations can be executed from this dialog. When finished, click the Done
button to remove the dialog. The Defgeneric Manager... command is not available when CLIPS
is executing.

Defgeneric Manager

13 Items

defgenaric-A " Remove
defgeneric-B —
defgeneric-C
defgeneric-D | ar———
defgeneric-E - m
defgeneric-F

defgeneric-G “ Methods...
defgeneric-H

defgeneric-|

defgeneric-] _! Watch

defgeneric-K
defgeneric-L

defgeneric-M %

The Remove button will remove the currently selected defgeneric. Pressing this button is
equivalent to an undefgeneric command. The Pprint button will pretty print the currently
selected defgeneric. Pressing this button is equivalent to a ppdefgeneric command. The Pprint
button echoes the equivalent CLIPS command and resulting output to the dialog window.

The Watch check box is used to enable or disable the messages that are printed when a generic
function begins and ends execution. If the check box for a deffunction is checked, then execution

messages for the generic function will be printed.

The Methods... button displays a dialog box allowing the defmethods for the currently selected
defgeneric to be browsed. The dialog box that appears in response to this button allows an op-
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eration to be performed on a defmethod selected from the list of defmethods currently in the
knowledge base.

Defgeneric Manager

13 ltems

Defmethod Manager

defgeneric-A - 11 ltems

1 (FLOAT) " Remove
2 (INTEGER) —_—
3 (NUMEBER)

7 (SYMBOL) (INTEGER) “ Pprint
9 (SYMBOL) (FLOAT) e
11 (SYMBOL) (NUMBER)

4 (SYMBOL) ,

6 (STRING) (INTEGER) — Watch
8 (STRING) (FLOAT)

10 (STRING) (NUMBER)

5 (STRING) € Done )

The Remove button will remove the currently selected defmethod. Pressing this button is
equivalent to an undefmethod command. The Pprint button will pretty print the currently
selected defmethod. Pressing this button is equivalent to a ppdefmethod command. The Pprint
button echoes the equivalent CLIPS command and resulting output to the dialog window.

The Watch check box is used to enable or disable the messages that are printed when a specific
method of a generic function begins and ends execution. If the check box for a defmethod is
checked, then execution messages for the method will be printed.

Any number of operations can be executed from this dialog. When finished, click the Done
button to return control to the Defgeneric Manager dialog box.

3.5.8 Defclass Manager...

This command displays a dialog box which allows the defclasses in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
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performed on a defclass selected from the list of defclasses currently in the knowledge base. Any
number of operations can be executed from this dialog. When finished, click the Done button to
remove the dialog. The Defclass Manager... command is not available when CLIPS is
executing.

Defclass Manager

18 ltems

A ; “ Remove
ADDRESS

EXTERMNAL-ADDRESS Describe
FACT-ADDRESS _ e
FLOAT Browse
IMITIAL-OBJECT —
IMSTARCE | Pprint
INSTAMNCE-ADDRESS P———
IMNSTAMCE-MAME
:_?;EE&R /! [ Watch Instances
MULTIFIELD | Watch Slots
MNUMEEE

OBJECT ;€ pone D

The Remove button will remove the currently selected defclass. Pressing this button is
equivalent to an undefclass command. The Describe button will describe the currently selected
defclass. Pressing this button is equivalent to a describe-class command. The Browse command
displays the class hierarchy for the currently selected defclass. Pressing this button is equivalent
to a browse-class command. The Pprint button will pretty print the currently selected defclass.
Pressing this button is equivalent to a ppdefclass command. The Describe, Browse, and Pprint
buttons echo the equivalent CLIPS command and resulting output to the dialog window.

The Watch Instances check box is used to enable or disable the messages that are printed when
an instance is created or deleted. If the check box for a defclass is checked, then messages will be
printed whenever an instance of that class is created or deleted. The Watch Slots check box is
used to enable or disable the messages that are printed when an instance’s slot values are
changed. If the check box for a defclass is checked, then messages will be printed whenever an
instance of that class has a slot value changed.

The Message Handlers... button displays a dialog box allowing the message handlers for the
currently selected class to be browsed. The dialog box that appears in response to this button
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allows an operation to be performed on a defmessage-handler selected from the list of
defmessage-handlers currently in the knowledge base.

Defclass Manager

18 ltems
Defmessage-Handler Manager
A - 11 ltems
defmessage-handler-A primary " Remove

defmessage-handler-B primary
defmessage-handler-C primary
defmessage-handler-D primary g
defmessage-handler-E primary _Pprint

defmessage-handler-F primary
defmessage-handler-G primary

defmessage-handler-H primary — Watch
defmessage-handler-l primary

defmessage-handler-] primary

defmessage-handler-K primary { Done

The Remove button will remove the currently selected defmessage-handler. Pressing this button
is equivalent to an undefmessage-handler command. The Pprint button will pretty print the
currently selected defmessage-handler. Pressing this button is equivalent to a ppdefmessage-
handler command. The Pprint button echoes the equivalent CLIPS command and resulting
output to the dialog window.

The Watch check box is used to enable or disable the messages that are printed when a message-
handler begins and ends execution. If the check box for a defmessage-handler is checked, then
execution messages for the message-handler will be printed.

Any number of operations can be executed from this dialog. When finished, click the Done
button to return control to the Defclass Manager dialog box.

3.5.9 Definstances Manager...

This command displays a dialog box which allows the definstances in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
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performed on a definstances selected from the list of definstances currently in the knowledge
base.

Definstances Manager

13 ltems

definstances-A " Remove
definstances-B —
definstances-C
definstances-D
definstances-E
definstances-F
definstances-G " Pprint

definstances-H —
definstances-I
definstances-]
definstances-k
definstances-L

definstances-M i—ﬁ’

The Remove button will remove the currently selected definstances. Pressing this button is
equivalent to an undefinstances command. The Pprint button will pretty print the currently
selected definstances. Pressing this button is equivalent to a ppdefinstances command. The
Pprint button echoes the equivalent CLIPS command and resulting output to the dialog window.
Any number of operations can be executed from this dialog. When finished, click the Done
button to remove the dialog. The Definstances Manager... command is not available when
CLIPS is executing.

3.5.10 Agenda Manager...

This command displays a dialog box which allows the activations on the agenda to be examined.
The dialog box that appears in response to this command allows any activation on the agenda to
be removed or fired.
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Agenda Manager

13 ltems

activation-3: f-1 F Remove
activation-8: f-1,f-2 —
activation-2: f-2

activation-6: f-2,f-1
activation-12: f-2,f-1
activation-11: f-1,1-3,
activation-10: -3 f  Fire 7
activation-13; f-3,f-2,f-1 -
activation-9: f-2,1-3
activation-1: f-3

activation-7: f-
activation-5; f-
activation-4: f-

-3
f-2

3,f-1
3,f-1
3,f-2

4

e I o I e I o J o I o N o N A i R = e Y e

Done )

The Remove button will remove the currently selected activation from the agenda. The Fire
button will place the currently selected activation at the top of the agenda (regardless of its
salience). The dialog is then exited and the CLIPS command (run 1) will then be echoed to the
Dialog Window, causing the activation to fire. Any number of remove operations (except the
Fire button) can be executed from this dialog. When finished, click the Done button to remove
the dialog. The Agenda Manager... command is not available when CLIPS is executing.
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3.6 THE WINDOW MENU

Dialog Window
Facts Window
Agenda Window
Instances Window
Globals Window
Focus Window

All Above

v rules.clp
¢ Untitled2

3.6.1 Dialog Window

This command selects the Dialog Window and brings it to the front. A check mark is placed by
the window name to indicated that it is the frontmost window. This command is available when
CLIPS is executing.

3.6.2 Facts Window

This command selects the Facts Window and brings it to the front. If the Facts Window does
not exist, it will be created. The Facts Window displays the list of facts in the fact-list. A check
mark is placed by the window name to indicated that it is the frontmost window. This command
is available when CLIPS is executing.

3.6.3 Agenda Window

This command selects the Agenda Window and brings it to the front. If the Agenda Window
does not exist, it will be created. The Agenda Window displays the list of activations currently
on the agenda. A check mark is placed by the window name to indicated that it is the frontmost
window. This command is available when CLIPS is executing.

CLIPS Interfaces Guide 65



CLIPS Reference Manual

3.6.4 Instances Window

This command selects the Instances Window and brings it to the front. If the Instances
Window does not exist, it will be created. The Instances Window displays the list of existing
instances and their slot values. A check mark is placed by the window name to indicated that it is
the frontmost window. This command is available when CLIPS is executing.

3.6.5 Globals Window

This command selects the Globals Window and brings it to the front. If the Globals Window
does not exist, it will be created. The Globals Window displays the list of global variables and
their current values. A check mark is placed by the window name to indicated that it is the
frontmost window. This command is available when CLIPS is executing.

3.6.6 Focus Window

This command selects the Focus Window and brings it to the front. If the Focus Window does
not exist, it will be created. The Focus Window displays the current focus stack. A check mark
is placed by the window name to indicated that it is the frontmost window. This command is
available when CLIPS is executing.

3.6.7 All Above

This command brings the Dialog Window, Facts Window, Instances Window, Globals
Window, and Focus Window in front of all other windows (creating them if they do not already
exist). The Dialog Window is selected as the active window. This command is available when
CLIPS is executing.

3.6.8 Titled and Untitled Edit Windows

This command brings the selected edit window to the front. All edit windows appear below the
All Above menu item. A check mark is placed by the window name to indicated that it is the
frontmost window. A diamond appears next to an edit window title that has changes that need to
be saved. The diamond is hollow if the edit window is not frontmost, otherwise it is filled. This
command is available when CLIPS is executing.
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3.7 CREATING THE MACINTOSH EXECUTABLES

3.7.1 Building the CLIPS Interface Executable Using Metrowerks CodeWarrior PR7

The following steps describe how to create the MacOS 9.x/X interface version of CLIPS using
Metrowerks CodeWarrior Professional Release 7. Note that some familiarity with building
applications using Metrowerks CodeWarrior is assumed. Section 2 of the Advanced
Programming Guide (which describes in general how to install and tailor CLIPS) should also be
read before attempting to build the Macintosh executables.

1) The following source files are needed to build the interface in addition to the source files for
the standard CLIPS executable:

alpha.h appevent.h apprsrcs.h brwsmenu.h
CLIPSCarbon.h clpscrap.h cooldlog.h displayw.h
dlogmngr.h dsplio.h dsplscrl.h dsplwdrg.h
editdlog.h editmenu.h editscrl.h editw.h
editwdrg.h execdlog.h factdlog.h filemenu.h
fontpick.h gnrcdlog.h interface.h kbstatw.h
macinit.h mainloop.h menucmds.h menuhndl.h
mpstrsrc.h prcddlog.h prefernc.h print.h
ruledlog.h search.h statusw.h stnrdmac.h
undo.h window.h

alpha.c appevent.c apprsrcs.c brwsmenu.c
cooldlog.c displayw.c dlogmngr.c dsplio.c
dsplscrl.c dsplwdrg.c editdlog.c editmenu.c
editscrl.c editw.c editwdrg.c execdlog.c
factdlog.c filemenu.c fontpick.c gnrcdlog.c
kbstatw.c macfuncs.c macinit.c macmain.c
mainloop.c menucmds.c menuhndl.c prcddlog.c
prefernc.c print.c ruledlog.c scrap.c
search.c statusw.c stnrdmac.c undo.c
window.c

CLIPS 620.rsrc Carbon.rsrc

2) Create a folder named CLIPS Project. Place the files CLIPS 620.mcp and CLIPS 620.rsrc
into this folder.

3) Create a folder named CLIPS Source and place it in the CLIPS Project folder. Copy all of
the standard CLIPS source code into the CLIPS Source folder. Create a folder named
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4)

5)

6)

7)

Interface Source and place it in the CLIPS Project folder. Copy all of the .c and .h source
code files for the Macintosh interface listed in step 1 into the Interface Source folder.

Double click on the CLIPS 620.mcp file.

Edit the setup.h file. Set the compiler directive flag MAC_MCW to 1 and set compiler
directive flag WINDOW_INTERFACE to 1.

Under the Project menu, select Set Default Target and choose CLIPS 6.20 Interface.

Under the Project Menu choose Make. The CLIPS 6.20 executable will be placed in the
CLIPS Project directory.

3.7.2 Building the CLIPS Console Executable Using Metrowerks CodeWarrior PR7

The following steps describe how to create the Macintosh console version of CLIPS using
Metrowerks CodeWarrior Professional Release 7:

1)
2)

3)

68

Follow steps 1 through 5 in section 3.8.1.
Under the Project menu, select Set Default Target and choose CLIPS 6.20 Console.

Under the Project Menu choose Make. The CLIPS 6.20 Console executable will be placed
in the CLIPS Project directory.
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Section 4 - CLIPS X Window Interface

This section provides a brief summary of the CLIPS 6.2 X Window interface (xclips) for systems
running X Windows. The menus are listed in the left to right order in which they appear in the
menu bar. The commands within each menu are also listed in the order in which they appear in
the menu.

The rest of the xclips is straightforward. Commands can be entered directly in the dialog window
in a fashion similar to the standard CLIPS command line interface.

By default, xclips is black and white. A resource file, Xclips, is provided to add color to the
interface. By default X will look for this resource file in the user’s home directory. A user can
modify his or her resource file if he or she wishes; however, it could be more convenient if he or
she uses the provided color utility, color. The color utility has to be in the same directory with
xclips, so it could be executed by xclips (see section 4.5.8).

The execution of the current command or CLIPS program can be halted by pressing Ctrl-H

Some menu commands are available while CLIPS is executing a user program. Among these
commands are the Options... menu item, the Watch... menu item, the Dribble... menu item, and
all menu items in Window menu. The command summary for each menu item indicates whether
it is available while CLIPS is executing. In addition, windows may be moved and resized while
CLIPS is executing.

4.1 THE 21 MENU

This command displays version information about CLIPS. Click the left mouse button in this
window to kill it. This command is not available when CLIPS is executing.
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4.2 THE FILE MENU

Edit... -

v
Load... ~L
Load Batch,..

Load Binary.,..
Dribble,.. ~0

4.2.1 Edit... (AV)

This command displays a file selection box, allowing the user to select a text file to edit. A new
window will be opened for each file (see section 4.6 for more details). This command is not
available when CLIPS is executing.

4.2.2 Complete... (*C)

This command “completes” the symbol currently being entered in the display window. The
symbol to be completed is always the last symbol in the display window. If no possible
completions exist, a beep is sounded. If only one possible completion exists (e.g. “deftemplat”
for “deftemplate”), then the symbol is automatically completed. If more than one completion
exists, a dialog is displayed showing all possible completions. The following dialog shows the
possible completions for the symbol “get”:
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Matches

gek

get-auto-float-dividend
get=-dynanic-def tenplate-checking
gebt-fact-duplication
get=-increnental-reset
get-rezet-globals
get=-zalience—-evaluation
geb-sktratepy

&

Click the Select button to complete the symbol with the current selection. Click the Cancel
button to terminate the dialog without any command completion. Note that symbols defined by
the user (as part of a construct or a CLIPS data structure such as a fact or instance) will also be
listed for command completion. This command is not available when CLIPS is executing.

4.2.3 Load... (A\L)

This command displays a file selection box, allowing the user to select a text file to be loaded
into the knowledge base. This command is equivalent to the CLIPS command (load <file-
name>). When this command is chosen and a file is selected, the appropriate CLIPS load
command will be echoed to the main window and executed. This command is not available when
CLIPS is executing.

4.2.4 Load Batch...

This command displays a file selection box, allowing the user to select a text file to be executed
as a batch file. This command is equivalent to the CLIPS command (batch <file-name>). When
this command is chosen and a file is selected, the appropriate CLIPS batch command will be
echoed to the main window and executed. This command is not available when CLIPS is
executing.
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4.2.5 Load Binary...

This command displays a file selection box, allowing the user to select a file to be loaded as a
binary image. This command is equivalent to the CLIPS command (bload <file-name>). When
this command is chosen and a file is selected, the appropriate CLIPS bload command will be
echoed to the main window and executed. This command is not available when CLIPS is
executing.

4.2.6 Dribble... (AN)

This command displays a file selection box, allowing the user to select a text file in which
subsequent display window output will be stored. This command is equivalent to the CLIPS
command (dribble-on <file-name>). When this command is chosen and a file is selected, the
appropriate CLIPS dribble-on command will be echoed to the main window and executed. While
the dribble file is active, this menu command will be modified to contain an X Window logo in
the left margin beside the command. Selecting the menu command at this time will close the
dribble text file and remove the X Window logo. This is equivalent to the CLIPS command
(dribble-off). This command is available when CLIPS is executing (however the commands will
not be echoed to the dialog window).

4.2.7 Save Binary...

This command allows the constructs currently stored in CLIPS to be saved as a binary image. A
dialog box will appear to prompt for the new file name in which to store the binary image. This
command is equivalent to the CLIPS command (bsave <file-name>). When this command is
chosen and a file is entered, the appropriate CLIPS bsave command will be echoed to the main
window and executed. This command is not available when CLIPS is executing.

4.2.8 Quit (*Q)

This command exits CLIPS. After choosing this command a Restart option is prompted. This
option will restart CLIPS using any new color resources created by the color utility (see section
4.5.8). This command is not available when CLIPS is executing.
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4.3 THE EXECUTION MENU

Execution

Bun
Step
Hatch...

Options,..

Clear CLIPS “K
Clear Hindow “H

4.3.1 Reset (AE)

This command is equivalent to the CLIPS command (reset). When this command is chosen, the
CLIPS command (reset) will be echoed to the main window and executed. If activations are
currently on the agenda, a dialog box will appear issuing a warning and providing an opportunity
to cancel this command. This command is not available when CLIPS is executing.

4.3.2 Run (AR)

This command is equivalent to the CLIPS command (run). When this command is chosen, the
CLIPS command (run) will be echoed to the main window and executed. This command is not
available when CLIPS is executing.

4.3.3 Step (AT)

This command is equivalent to the CLIPS command (run 1). When this command is chosen, the
CLIPS command (run 1) will be echoed to the main window and executed. This command is not
available when CLIPS is executing.

4.3.4 Watch...

This command displays a dialog box which allows the user to set various watch items as enabled
or disabled.
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Watch Menu

Watch items can be enabled or disabled by clicking its check box. Enabled watch items have a
check in their check box. Disabled watch items have no check mark in their check box. Pressing
the All button checks all of the watch item check boxes. Pressing the None button unchecks all
of the watch item check boxes. Clicking the Okay button exits the dialog and changes the
current watch settings to those shown in the dialog. Clicking the Cancel button exits the dialog,
but retains the original settings of the watch items before the dialog was entered.

This command is available when CLIPS is executing.
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4.3.5 Options...

This command displays a dialog box which allows the user to set various CLIPS execution
options.

Execution Options

Salience Evaluation wpr

Static Constraint Checking

Dynanic Constraint Checking

Reset Global Yariables

Sequence Expanzion Operator

Increnental Reset
Auto-Float Dividend

Fact Duplication

The Salience Evaluation pop-up menu allows the current salience evaluation behavior to be
changed (to either when-defined, when-activated, or every-cycle). The Strategy pop-up menu
allows the current conflict resolution strategy to be changed (to either depth, breadth, lex, mea,
complexity, simplicity, or random). The Static Constraint Checking, Dynamic Constraint
Checking, Reset Global Variables, Sequence Expansion Operator Recognition, Incremental
Reset, Auto-Float Dividend, and Fact Duplication check boxes are used to enable and disable
the named CLIPS option. Enabled options have a check in their check box while disabled items
have none. The Incremental Reset option cannot be changed if any defrules are currently
defined. Clicking the OK button exits the dialog and changes the CLIPS execution options
settings to those shown in the dialog. Clicking the Cancel button exits the dialog, but retains the
original settings of the CLIPS execution options before the dialog was entered.

This command is available when CLIPS is executing.
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4.3.6 Clear CLIPS (*K)

This command is equivalent to the CLIPS command (clear). When this command is chosen, the
CLIPS command (clear) will be echoed to the main window and executed. A dialog box will
appear issuing a warning and providing an opportunity to cancel this command. This command
is not available when CLIPS is executing.

4.3.7 Clear Window (AN)

This command clears the dialog window. This command is not available when CLIPS is
executing.

4.4 THE BROWSE MENU

Brouse

Hodule,..

Defrule Hanager...
Deffacts Hanager...
Deftenplates Hanager...
Def function Hanager...

Defglobal Hanager.,..
Defgeneric Hanager,..,
Defclass Hanager...

Def instances Hanager...
Agenda Hanager...
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4.4.1 Module Menu

This menu displays a dialog box which contains the list of the defmodules currently defined in
the CLIPS environment. A current module is hilighted. Selecting a module from the list changes
the current module to the selected item.

Defimodule

AODULE-A

AODULE-B
AODULE-C

When finish selecting the module click the Done button to remove the dialog.
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4.4.2 Defrule Manager...

This command displays a dialog box which allows the defrules in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
performed on a defrule selected from the list of defrules currently in the knowledge base.

Defrule Manager - 13 Items

[dofrulo-n T |
defrule-B ;
defrule-C I Refresh Ig
defrule-0 ;
defrule-E I Hatches Ig
defrule-F 5
defrule=-G
defrule=-H
defrule=-I
defrule=.l
defrule=K
defrule-L
defrule-H

The Remove button will remove the currently selected defrule. Pressing this button is equivalent
to issuing an undefrule command. The Refresh button will refresh the currently selected
defrule. Pressing this button is equivalent to a refresh command. The Matches command will
list the matches for the currently selected defrule. Pressing this button is equivalent to a matches
command. The Pprint button will pretty print the currently selected defrule. Pressing this button
is equivalent to a ppdefrule command. Both the Matches and Pprint buttons echo the
equivalent CLIPS command and resulting output to the dialog window.

The Breakpoint check box is used to enable or disable a breakpoint on the currently selected
defrule. Rules with a breakpoint set have a check in their check box while rules without a
breakpoint have none. The Watch Activations check box is used to enable or disable the
messages that are printed when a rule is activated or deactivated. If the check box for a rule is
checked, then activation/deactivation messages for the rule will be printed. The Watch Firings
check box is used to enable or disable the messages that are printed when a rule is executed. If
the check box for a rule is checked, then execution messages for the rule will be printed.
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Any number of operations can be executed from this dialog. When finished, click the Done
button to remove the dialog. The Defrule Manager... command is not available when CLIPS is
executing.

4.4.3 Deffacts Manager...

This command displays a dialog box which allows the deffacts in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
performed on a deffacts selected from the list of deffacts currently in the knowledge base.

Deffacts Manager - 13 ltems

deffacts-A
deffacts-B
deffacts-C
deffacts-0
deffacts-E
deffacts-F
deffacts-G
deffacts-H
deffacts-I
deffacts-J
deffacts-K
deffacts-L
deffacts-H

The Remove button will remove the currently selected deffacts. Pressing this button is
equivalent to an undeffacts command The Pprint button will pretty print the currently selected
deffacts. Pressing this button is equivalent to a ppdeffacts command. The Pprint button echoes
the equivalent CLIPS command and resulting output to the dialog window. Any number of
operations can be executed from this dialog. When finished, click the Done button to remove the
dialog. The Deffacts Manager... command is not available when CLIPS is executing.
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4.4.4 Deftemplate Manager...

This command displays a dialog box which allows the deftemplates in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
performed on a deftemplate selected from the list of deftemplates currently in the knowledge
base.

Deftemplate Manager - 13 ltems

deftenplate-B
deftenplate-C
deftenplate-0
deftenplate-E
deftenplate-F
deftenplate-G
deftenplate-H
deftenplate-I
deftenplate-J
deftenplate-K
deftenplate-L
deftenplate-H

The Remove button will remove the currently selected deftemplate. Pressing this button is
equivalent to an undeftemplate command. The Pprint button will pretty print the currently
selected deftemplate. Pressing this button is equivalent to a ppdeftemplate command. The
Pprint button echoes the equivalent CLIPS command and resulting output to the dialog window.

The Watch check box is used to enable or disable the messages that are printed whenever a fact
is asserted or retracted. If the check box for a deftemplate is checked, then assert/retract
messages for facts associated with the deftemplate will be printed.

Any number of operations can be executed from this dialog. When finished, click the Done

button to remove the dialog. The Deftemplate Manager... command is not available when
CLIPS is executing.
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4.4.5 Deffunction Manager...

This command displays a dialog box which allows the deffunctions in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
performed on a deffunction selected from the list of deffunctions currently in the knowledge
base.

Deffunction Manager - 13 ltems

def function-B
def function-C
def function-0
def function-E
def function-F
def function-G
def function-H
def function-I
deffunction=-.J
deffunction-K
deffunction-L
deffunction-H

The Remove button will remove the currently selected deffunction. Pressing this button is
equivalent to an undeffunction command. The Pprint button will pretty print the currently
selected deffunction. Pressing this button is equivalent to a ppdeffunction command. The
Pprint button echoes the equivalent CLIPS command and resulting output to the dialog window.

The Watch check box is used to enable or disable the messages that are printed when a
deffunction begins and ends execution. If the check box for a deffunction is checked, then
execution messages for the deffunction will be printed.

Any number of operations can be executed from this dialog. When finished, click the Done

button to remove the dialog. The Deffunction Manager... command is not available when
CLIPS is executing.
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4.4.6 Defglobal Manager

This command displays a dialog box which allows the defglobals in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
performed on a defglobal selected from the list of defglobals currently in the knowledge base.
Any number of operations can be executed from this dialog. When finished, click the Done
button to remove the dialog. The Defglobal Manager... command is not available when CLIPS
is executing.

Defglobal Manager - 13 Items

Remove
defglobal-B
defglobal-CC Pprint
defglobal-D
defglobal-E
defglobal-F
defglobal-G
defglobal-H
defglobal-I
defglobal-J
defglobal-K
defglobal-L
defglobal-H

The Remove button will remove the currently selected defglobal. Pressing this button is
equivalent to an undefglobal command The Pprint button will pretty print the currently selected
deffacts. Pressing this button is equivalent to a ppdefglobal command. The Pprint button echoes
the equivalent CLIPS command and resulting output to the dialog window. Any number of
operations can be executed from this dialog. When finished, click the Done button to remove the
dialog. The Defglobal Manager... command is not available when CLIPS is executing.

4.4.7 Defgeneric Manager

This command displays a dialog box which allows the defgenerics in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
performed on a defgeneric selected from the list of defgenerics currently in the knowledge base.
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Any number of operations can be executed from this dialog. When finished, click the Done
button to remove the dialog. The Defgeneric Manager... command is not available when CLIPS
is executing.

Defgeneric Manager - 13 ltems

Ronove
defgeneric-B

defgeneric-C Pprint
defgeneric-D

defgeneric=-E Hethods, ..
defgeneric-F

defgeneric-G
defgeneric-H

defgeneric-I

defgeneric-.J

defgeneric-K

defgeneric-L

defgeneric-H

The Remove button will remove the currently selected defgeneric. Pressing this button is
equivalent to an undefgeneric command. The Pprint button will pretty print the currently
selected defgeneric. Pressing this button is equivalent to a ppdefgeneric command. The Pprint
button echoes the equivalent CLIPS command and resulting output to the dialog window.

The Watch check box is used to enable or disable the messages that are printed when a generic
function begins and ends execution. If the check box for a deffunction is checked, then execution
messages for the generic function will be printed.

The Methods... button displays a dialog box allowing the defmethods for the currently selected
defgeneric to be browsed. The dialog box that appears in response to this button allows an op-
eration to be performed on a defmethod selected from the list of defmethods currently in the
knowledge base.
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defyeneric - A Defmethod Manager - 11 ltems

(FLOAT?}

{STRING HUNBER}
{SYHBOL HUNBER}
{INTEGER}
{HUHBER}
{SYHBOL }
{STRING}

{STRING THTEGER}
{SYHBOL THTEGER}
({STRING FLOAT?
({SYHBOL FLOAT?

[l

1
1
1
2
3
4
5
b
7
8
9

The Remove button will remove the currently selected defmethod. Pressing this button is
equivalent to an undefmethod command. The Pprint button will pretty print the currently
selected defmethod. Pressing this button is equivalent to a ppdefmethod command. The Pprint
button echoes the equivalent CLIPS command and resulting output to the dialog window.

The Watch check box is used to enable or disable the messages that are printed when a specific
method of a generic function begins and ends execution. If the check box for a defmethod is
checked, then execution messages for the method will be printed.

Any number of operations can be executed from this dialog. When finished, click the Done
button to return control to the Defgeneric Manager dialog box.

4.4.8 Defclass Manager...

This command displays a dialog box which allows the defclasses in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
performed on a defclass selected from the list of defclasses currently in the knowledge base. Any
number of operations can be executed from this dialog. When finished, click the Done button to
remove the dialog. The Defclass Manager... command is not available when CLIPS is
executing.
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Defclass Manager - 18 ltems

ADDRESS Renove
EXTERHAL-ADDRESS Describe
FACT-ADDRESS

FLOAT Browse
IHITIAL-0BJECT

IHS5TAHCE Pprint

IHSTRAHCE-RADDRESS
IHSTAHCE=-HAHE Hezzage Handlers,..

IHTEGER
LEXEHE D Hatch Instances

HULTIFIELD D Hatch Slots
HUHBER

0BJECT

PRIHITIYE

STRIHG

SYHBOL

USER

The Remove button will remove the currently selected defclass. Pressing this button is
equivalent to an undefclass command. The Describe button will describe the currently selected
defclass. Pressing this button is equivalent to a describe-class command. The Browse command
displays the class hierarchy for the currently selected defclass. Pressing this button is equivalent
to a browse-class command. The Pprint button will pretty print the currently selected defclass.
Pressing this button is equivalent to a ppdefclass command. The Describe, Browse, and Pprint
buttons echo the equivalent CLIPS command and resulting output to the dialog window.

The Watch Instances check box is used to enable or disable the messages that are printed when
an instance is created or deleted. If the check box for a defclass is checked, then messages will be
printed whenever an instance of that class is created or deleted. The Watch Slots check box is
used to enable or disable the messages that are printed when an instance’s slot values are
changed. If the check box for a defclass is checked, then messages will be printed whenever an
instance of that class has a slot value changed.

The Message Handlers... button displays a dialog box allowing the message handlers for the
currently selected class to be browsed. The dialog box that appears in response to this button
allows an operation to be performed on a defmessage-handler selected from the list of
defmessage-handlers currently in the knowledge base.
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DEFCLASS-A Defmessage - Handler Manager - 12 Items

defnessage-handler-H prinary

defnessage-handler-B primary

defnessage-handler-C prinary
defnessage-handler=0 primary :
defmnessage-handler-E prinmary
defnesszage-handler-F primary

defnessage-handler-G primary

defnesszage-handler-H primary

defnessage-handler=1 primary

defneszage-handler-.J primary

defnessage-handler-K primary
defneszage-handler-L primary

The Remove button will remove the currently selected defmessage-handler. Pressing this button
is equivalent to an undefmessage-handler command. The Pprint button will pretty print the
currently selected defmessage-handler. Pressing this button is equivalent to a ppdefmessage-
handler command. The Pprint button echoes the equivalent CLIPS command and resulting
output to the dialog window.

The Watch check box is used to enable or disable the messages that are printed when a message-
handler begins and ends execution. If the check box for a defmessage-handler is checked, then
execution messages for the message-handler will be printed.

Any number of operations can be executed from this dialog. When finished, click the Done
button to return control to the Defclass Manager dialog box.

4.4.9 Definstances Manager...

This command displays a dialog box which allows the definstances in the knowledge base to be
examined. The dialog box that appears in response to this command allows an operation to be
performed on a definstances selected from the list of definstances currently in the knowledge
base.
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Definstance Manager - 13 ltems

Gof instancesh

def instances-B
definstances-C Pprint
def instances-0
def instances-E
def instances-F
def instances-G
def instances-H
def instances-.l

def instances-K
definstances-L
def instances-H
initial=-ob ject

The Remove button will remove the currently selected definstances. Pressing this button is
equivalent to an undefinstances command. The Pprint button will pretty print the currently
selected definstances. Pressing this button is equivalent to a ppdefinstances command. The
Pprint button echoes the equivalent CLIPS command and resulting output to the dialog window.
Any number of operations can be executed from this dialog. When finished, click the Done
button to remove the dialog. The Definstances Manager... command is not available when
CLIPS is executing.

4.4.10 Agenda Manager...

This command displays a dialog box which allows the activations on the agenda to be examined.
The dialog box that appears in response to this command allows any activation on the agenda to
be removed or fired.
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activation-d:
activation-5:
activation-7:
activation-1:
activation-10: -3
activation-9:
activation-11
activation-12
activation-6:
activation-2:
activation-8:
activation-3:

-
-+
-+
-

0
0
0
0
0
0
0
0
0
0
0
0
0

The Remove button will remove the currently selected activation from the agenda. The Fire
button will place the currently selected activation at the top of the agenda (regardless of its
salience). The dialog is then exited and the CLIPS command (run 1) will then be echoed to the
Dialog Window, causing the activation to fire. Any number of remove operations (except the
Fire button) can be executed from this dialog. When finished, click the Done button to remove
the dialog. The Agenda Manager... command is not available when CLIPS is executing.
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4.5 THE WINDOW MENU

Hindous

Facts Hindow

Agenda Hindow
Instances Hindow
Global Hindow

Focus Hindow

All Hindows
Mone

Comnand Line CLIPS ~7
Color Utility

4.5.1 Facts Window

This command creates or deletes the Facts Window. The Facts Window displays the list of
facts in the fact-list. An X Window logo is placed by the window name to indicated that it exists.
This command is available when CLIPS is executing.

4.5.2 Agenda Window

This command creates or deletes the Agenda Window. The Agenda Window displays the list of
activations currently on the agenda. An X Window logo is placed by the window name to
indicated that it exists. This command is available when CLIPS is executing.

4.5.3 Instances Window

This command creates or deletes the Instances Window. The Instances Window displays the
list of existing instances and their slot values. A check mark is placed by the window name to
indicated that it exists. This command is available when CLIPS is executing.

4.5.4 Globals Window

This command creates or deletes the Globals Window. The Globals Window displays the list of
global variables and their current values. A check mark is placed by the window name to
indicated that it exists. This command is available when CLIPS is executing.
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4.5.5 Focus Window

This command selects the Focus Window and brings it to the front. If the Focus Window does
not exist, it will be created. The Focus Window displays the current focus stack. A check mark
is placed by the window name to indicated that it is the frontmost window. This command is
available when CLIPS is executing.

4.5.6 All

This command creates the Dialog Window, Facts Window, Instances Window, and Globals
Window if they do not already exist. This command is available when CLIPS is executing.

4.5.7 None

This command deletes the Dialog Window, Facts Window, Instances Window, and Globals
Window if they exist. This command is available when CLIPS is executing.

4.5.8 Command Line CLIPS (AZ)

This command creates a xterm window and starts a command line version of CLIPS. This
window will still exist after the xclips interface has ended. This command is available when
CLIPS is executing.

4.5.9 Color Utility
This command will execute the color utility for the xclips interface. To use the new colors the
Quit command with the Restart (see section 4.2.9) option must be chosen.

4.5.9.1 How To Use The Color Utility

To change the colors of a window in the X Window interface for CLIPS, the user must:
1) Select the appropriate button for the window at the bottom of the color utility.

2) Select the item that needs to be changed at the top of the color utility.

3) Select the color that is listed on the left of the color utility.

The instant visual changes on the window will help the user to decide which colors he/she likes
best. There are 14 different buttons at the bottom of the color utility that the user can select. They

are listed as follows:

Dialog Window: The main interactive window that accepts input from users and prints out
output from CLIPS.
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Facts Window: The fact window that contains all the facts in the fact base.
Instance Window: The instance window that contains all the instances.

Globals: The global window that contains all the global variables and their values.
Agenda Window: The agenda window that contains all the activated rules.

Focus Window: The focus window that contains all the modules in the stack.

Button Box: The box that contains all the top level menu buttons. Only the background color
can be changed here.

Menu Buttons: All the top level menu buttons.

Pulldown Menus: All the pulldown menus.

Managers: All the defconstruct manager windows (under the Browse menu).

Managers Button: There are regular buttons and a Cancel button, which the user can modify
their colors, in a manager window. Their foreground color and their border color will always be
the same.

Confirmation: The confirmation dialog box.

File: The file selection window which popups when the name of a file is needed.

Watch/Options: The windows that allow the user to select the watched items and the options
(created using the Watch and Options menu items).

Wtch/Opt Bttns : Toggle buttons and command buttons in the Watch or Options menu items.

On the top of the color utility there are five buttons the user can select, Foreground,
Background, Border, Default, Quit. When the foreground and border colors are not allowed to
change, the label of the Foreground and Border buttons will change to N/A or to something
else that appropriate for the current selected button at the bottom of the color utility. Clicking on
Default will give the user the default colors. When the user is happy with his/her selections and
wants to save them, she/he can click on Save and Quit under the Quit menu. Selecting Save
and Quit instructs the color utility to save the current color resource setting in the file Xclips
which must reside in the user’s home directory.
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4.6 THE EDITOR

This section provides a brief summary for the editor interface. The editor is an instance of the
Athena asciiText widget, which comes with X and is similar to the emacs editor.

4.6.1 File

Save
Save Hs
Revert

Load Selection
Batch Selection
Load Buffer

4.6.1.1 Save

This command displays a dialog box allowing the user to overwrite the old file with the edited
file or cancel the save command. This command is not available when CLIPS is executing.

4.6.1.2 Save As

This command allows the edit window to be saved under a new name. A dialog box will appear
to prompt for the new file name. The name of the editing window will be changed to the new file
name. This command is not available when CLIPS is executing.

4.6.1.3 Revert
This command restores the edit window to the last saved version of the file in the buffer. Any

changes made since the file was last saved will be discarded. This command is not available
when CLIPS is executing.

4.6.1.4 Load Selection

This command loads the current selection in the active edit window into the CLIPS knowledge
base. Standard error detection and recovery routines used to load constructs from a file are also
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used when loading a selection (i.e., if a construct has an error in it, the rest of the construct will
be skipped over until another construct to be loaded is found). This command is not available
when CLIPS is executing.

4.6.1.5 Batch Selection

This command treats the current selection in the active edit window as if it were a batch file and
executes it as a series of commands. Standard error detection and recovery routines used to load
construct from a file are notr used when batching a selection (i.e., if a construct has an error in it,
a number of ancillary errors may be generated by subsequent parts of the same construct
following the error). This command is not available when CLIPS is executing.

4.6.1.6 Load Buffer

This command loads the contents of the active edit window into the CLIPS knowledge base. It is
equivalent to selecting the entire buffer and executing a Load Selection command. This
command is not available when CLIPS is executing.

4.6.1.7 Exit

This command exits the editor. This command is not available when CLIPS is executing.

4.6.2 Edit

Complete,... ~C

Cut

Paste
Search/Replace...
Balance “B

Beginning of File
End of File

4.6.2.1 Complete... ("C)

This command “completes” the symbol currently being entered in the active edit window. The
symbol being completed is the current selection, or if no selection exists, the symbol to the left of

CLIPS Interfaces Guide 93



CLIPS Reference Manual

the current insertion point. If no possible completions exist, a beep is sounded. If only one
possible completion exists (e.g. “deftemplat” for “deftemplate”), then the symbol is
automatically completed. If more than one completion exists, a dialog is displayed showing all
possible completions. The following dialog shows the possible completions for the symbol “get”:

Matches

gek

get-auto-float-dividend
get-dynanic-deftenplate-checking
gebt-fact-duplication
get=-increnental-reset
get-reset-globals
get-zalience—-evaluation
get-strategy

&

Click the Select button to complete the symbol with the current selection. Click the Cancel
button to be terminate the dialog without any command completion. Note that symbols defined
by the user (as part of a construct or a CLIPS data structure such as a fact or instance) will also
be listed for command completion. This command is not available when CLIPS is executing.
4.6.2.2 Cut

This command removes selected text in the active edit window and places it in the Clipboard.
This command is not available when CLIPS is executing.

4.6.2.3 Paste

This command copies the contents of the Clipboard to the selection point in the edit window.
This command is not available when CLIPS is executing.
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4.6.2.4 Search/Replace... (AS/AR)

This command displays the search/replace dialog allowing the user to search for a string or
search for a string and replace it with another string. This command is not available when CLIPS
is executing.

4.6.2.5 Balance (AB)

This command operates on the current selection in the active edit window by attempting to find
the smallest selection containing the current selection which has balanced parentheses. Repeat-
edly using this command will select larger and larger selections of text until a balanced selection
cannot be found. The balance command is a purely textual operation and can be confused by
parentheses found in strings. The cursor has to be placed to the left of the parenthesis. This
command is not available when CLIPS is executing.

4.6.2.6 Beginning of File

This command will scroll the insertion point to the beginning of the editor file and then scroll the
minimum amount necessary to make the new insert point location visible. This command is not
available when CLIPS is executing.

4.6.2.7 End of File

This command will scroll the insertion point to the end of the editor file and then scroll the
minimum amount necessary to make the new insert point location visible. This command is not
available when CLIPS is executing.

4.6.3 Font

hxd

Gx10
6x13bold
7x13bold

8x13bold
9x15bold
10x20
12424
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4.6.3.1 5x8

This command will set the editor font to 5x8. This command is not available when CLIPS is
executing.

4.6.3.2 6x10

This command will set the editor font to 6x10. This command is not available when CLIPS is
executing.

4.6.3.3 6x13bold

This command will set the editor font to 6x13bold. This command is not available when CLIPS
is executing.

4.6.3.4 7x13bold

This command will set the editor font to 7x13bold. This command is not available when CLIPS
is executing.

4.6.3.5 8x13bold

This command will set the editor font to 8x13bold. This command is not available when CLIPS
is executing.

4.6.3.6 9x15bold

This command will set the editor font to 9x15bold. This command is not available when CLIPS
is executing.

4.6.3.7 10x20

This command will set the editor font to 10x20. This command is not available when CLIPS is
executing.

4.6.3.8 12x24

This command will set the editor font to 12x20. This command is not available when CLIPS is
executing.
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4.6.4 Help

Key Bindings

4.6.4.1 Key Bindings

This command displays a list of all key bindings available for the editor. This command is not
available when CLIPS is executing.

4.7 BUILDING THE CLIPS X WINDOW INTERFACE

The following steps describe how to create the X Window machine specific version of CLIPS.
This version of the CLIPS X Window interface requires X Window system release 11R6.4 and
has been tested on a Macintosh running MacOS X.1 with Tenon Xtools version 1.0.4p1. Note
that some familiarity with building applications using C compilers in a UNIX environment is
assumed. Section 2 of the Advanced Programming Guide (which describes in general how to
install and tailor CLIPS) should also be read before attempting to build the X Window
executables.

1) The following source files are needed to build the interface in addition to the source files for
the standard CLIPS executable:

xclips.h xedit.h xmain.h xmenu.h
xmenu_wind.h xsetup.h

xclips.c xclipstext.c xedit.c Xxmain.c
Xmenu.c Xmenu_exec.c xmenu_file.c xmenu_opt.c
xmenu_watch.c xmenu_wind.c

Xclips

The file Xclips is a resource file that must reside in the user’s home directory in order for
the X Window interface to appear in color. If this file cannot be found, the X Window
interface will appear in black and white.

2) The compiler directive flags UNIX_7 and WINDOW_INTERFACE in the file setup.h
should be set to 1.
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3)

4)

98

The X Window system interface version of CLIPS can be created by compiling all the
standard CLIPS .c files and the .c files listed in step 1. The file xmain.c replaces the file
main.c used in the standard CLIPS (and thus main.c should not be compiled). The resulting
object files should then be linked with the following libraries: Xaw, Xmu, Xt, Xext, X11, m.
An example UNIX command for compiling xclips is shown following:

gcc -o xclips *.c -1Xaw -1Xmu -1Xt -1Xext -1X11 -1m

Alternately, a makefile named “makefile.x” is included with the X Windows source. This
file can be renamed “makefile” and used with themake program.

The color utility is a stand alone application. The source code files for this application are
color.c, default.h, and colors.h. The executable version of the color utility can be generated
by compiling color.c and linking it with the following libraries: Xaw, Xmu, Xt, Xext, X11.

An example UNIX command for compiling the color utility is shown following:

gcc -o color color.c -1lXaw -1Xmu -1Xt -1Xext -1X11
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Appendix A - Update Release Notes

The following sections denote the changes and bug fixes for CLIPS versions 6.01, 6.02, 6.03,
and 6.04, 6.05, and 6.10.

A.1 VERSION 6.20

* Windows Interface Changes - The following enhancements were added by the 6.20
release:

e CLIPS engine and editor applications combined into a single Windows 95/98/NT
Multiple Document Interface application.

* Macintosh Interface Changes - The following enhancements were added by the 6.20
release:

*  MacOS X support.

A.2 VERSION 6.10

*  Windows Interface Bug Fixes - The following bugs were fixed by the 6.10 release:

* The Windows 95 CLIPS interface did not properly display strings containing two
sequential carriage returns.

* Refresh and scroll bar bugs occurredwhen running the Windows 95 CLIPS interface
under Windows NT.

* Macintosh Interface Changes - The following enhancements were added by the 6.10
release:

e DOS/Unix line breaks are automatically converted to MacOS line breaks when a file is
opened using the Open... menu item from the File menu.

A.3 VERSION 6.05

*  Windows Editor Interface Bug Fixes - The following bugs were fixed by the 6.05 release:

e If Quit Editor was selected from the File Menu before changes were saved, the cancel
button of the save dialog did not abort the quit.

* X Windows Interface Bug Fixes - The following bugs were fixed by the 6.05 release:
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* A crash bug could occur in file dialogs when changing directories.

Macintosh Interface Changes - The following enhancements were added by the 6.05
release:

e In an editing window, the left margin is padded with the same number of spaces as found
in the left margin of the previous line when the return key is pressed.

* A mark is placed by edit buffer window in the Windows menu to indicate whether it
have been changed.

* Home, end, page up, page down, left arrow, right arrow, up arrow, and down arrow keys
work for the Display Window and edit windows.

¢ Added Comment, Uncomment, and Select All menu items to the Edit Menu.

* Window position, selection, scroll positions, and font are remembered for edit windows.
The position of the Display Window and other status windows are remembered.

*  When a right parenthesis is typed, the matching left parenthesis will be momentarily
highlighted.

* Watch, execution, and other preferences are now stored in a preference file and restored
the next time the application is launched.

e Edit windows now contain a constructs pop-up menu in the lower left corner containing
a list of constructs found in the window text.

e The 8 = command key is now used for the Replace menu item.

e The 8 T command key is now used for the Replace & Find Again menu item.

e Enter Find String and Find Selection menu items were added to the Buffer menu.

e The Execution menu has been renamed to the Command menu. The Reset, Run, Step,

and Clear menu items have been removed. Ten user definable commands now displayed
in this menu along with a Set Commands... menu item for defining them.
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